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Be Incorporated License Agreement

o READ THIS BEFORE INSTALLING THE BEOS.

BY INSTALLING THE BEOS YOU AGREE THAT YOU HAVE READ THIS LICENSE, THAT YOU ARE 
BOUND BY ITS TERMS AND THAT IT IS THE ONLY AGREEMENT BETWEEN US REGARDING THE 
PROGRAM AND DOCUMENTATION.

INSTALLING THE BEOS INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.
READ ALL OF THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT PRIOR TO 
INSTALLING. IF YOU DO NOT ACCEPT THESE TERMS, YOU MUST RETURN THE BEOS AND ANY 
UNOPENED PACKAGE (PACKET AND ALL OTHER MATERIALS) WITHIN 5 DAYS OF OBTAINING 
THE BEOS, WITH YOUR RECEIPT, AND YOUR MONEY WILL BE RETURNED.

PLEASE NOTE THAT YOU MAY NOT USE, COPY, MODIFY OR TRANSFER THE PROGRAM OR 
DOCUMENTATION OR ANY COPY, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

LICENSE

This software program and documentation are licensed, not sold, to you. You have a non-exclusive 
and nontransferable right to use the enclosed program and documentation. This program can only be 
used on a single computer located in the United States and its territories or any other country to which 
this software is legally exported. You may physically transfer the program from one computer to 
another provided that the program is used on only one computer at a time. This software is considered 
to be in use on a computer when it is loaded into the temporary memory (i.e., RAM) or installed into 
the permanent memory (e.g., hard drive) of that computer, except that a copy installed on a network 
server for the sole purpose of distribution to other computers is not “in use.” You may merge it into 
another program for your use on a single machine. You agree that the program and documentation 
belong to Be Incorporated and its licensors. You agree to use your best efforts to prevent and protect 
the contents of the program and documentation from unauthorized disclosure or use. Be Incorporated 
and its licensors reserve all rights not expressly granted to you.

LIMITATIONS ON USE

You may not rent, lease, sell or otherwise transfer or distribute copies of the program or documentation 
to others. You may not modify or translate the program or the documentation without the prior written 
consent of Be Incorporated. You may not reverse assemble, reverse compile or otherwise attempt to 
create the source code from the program. Licensee shall not use Be Incorporated's name or refer to Be 
Incorporated directly or indirectly in any papers, articles, advertisements, sales presentations, news 
releases or releases to any third party without the prior written approval of Be Incorporated for each 
such use. Licensee shall not release the results of any performance or functional evaluation of any 
program to any third party without prior written approval of Be Incorporated for each such release.
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BACKUP AND TRANSFER

You may make one copy of the program for backup purposes if Be Incorporated’s copyright notice is 
included. You may not sublicense the program, or assign, delegate or otherwise transfer this license or 
any of the related rights or obligations for any reason. Any attempt to make any such sublicense, 
assignment, delegation or other transfer by you shall be void.

COPYRIGHT

The program and related documentation are copyrighted. You may not copy any documentation. You 
may not copy the program (or this license) except to provide a backup copy and to load the program 
into the computer as part of executing the program. Any and all other copies of the program made by 
you are in violation of this license.

OWNERSHIP

You agree that you neither own nor hereby acquire any claim or right of ownership to the program and 
documentation or to any related patents, copyrights, trademarks or other intellectual property. You 
own only the magnetic or other physical media on which the program and related documentation are 
recorded or fixed. Be Incorporated and its licensors retain all right, title and interest in and to the 
documentation and all copies and the program recorded on the original media and all subsequent 
copies of the program at all times, regardless of the form or media in or on which the original or other 
copies may subsequently exist. This license is not a sale of the original or any subsequent copy.

TERM AND TERMINATION

This license is effective until terminated. You may terminate this license at any time by destroying the 
program and documentation and the permitted backup copy. This license automatically terminates if 
you fail to comply with its terms and conditions. You agree that, upon such termination, you will 
destroy (or permanently erase) all copies of the program and documentation. You also agree that, 
upon termination, you will return the original program and documentation to Be Incorporated, together 
with any other material you have received from Be Incorporated in connection with the program.

LIMITED WARRANTY

Be Incorporated warrants the media on which the program is furnished to be free from defects in 
materials and workmanship under normal use for 30 days from the date that you obtain the program. 
EXCEPT FOR THIS LIMITED WARRANTY, BE INCORPORATED AND ITS LICENSORS PROVIDE THE 
PROGRAM AND THE DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND EITHER 
EXPRESS, IMPLIED OR STATUTORY, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES 
OF TITLE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.

Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to 
you. This warranty gives you specific legal rights and you may also have other rights which vary from 
state to state.
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The BeOS may have been delivered to you bundled with third party software applications not owned 
by Be Incorporated. SUCH THIRD PARTY SOFTWARE IS PROVIDED TO YOU “AS IS” AND WITHOUT 
WARRANTY OF ANY KIND BY BE INCORPORATED EITHER EXPRESS, IMPLIED OR STATUTORY, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF TITLE, MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. Your rights and warranties, if 
any, regarding such third party software are governed by such third party's own end user license 
agreement and not by Be Incorporated.

LIMITATION OF REMEDIES

Be Incorporated and its licensors’ entire liability and your exclusive remedy in connection with the 
program and the documentation shall be that you are entitled to return the defective media containing 
the program together with the documentation to the merchant. At the option of the merchant, you may 
receive replacement media containing the program and documentation that conforms with the limited 
warranty or a refund of the amount paid by you. IN NO EVENT WILL BE INCORPORATED OR ITS 
LICENSORS BE LIABLE FOR ANY INDIRECT DAMAGES OR OTHER RELIEF ARISING OUT OF YOUR 
USE OR INABILITY TO USE THE PROGRAM OR ANY THIRD PARTY APPLICATIONS INCLUDING, BY 
WAY OF ILLUSTRATION AND NOT LIMITATION, LOST PROFITS, LOST BUSINESS OR LOST 
OPPORTUNITY, OR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
SUCH USE OR INABILITY TO USE THE PROGRAM OR ANY THIRD PARTY APPLICATIONS, EVEN IF 
BE INCORPORATED, ITS LICENSORS OR AN AUTHORIZED BE INCORPORATED DEALER, 
DISTRIBUTOR OR SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR 
FOR ANY CLAIM BY ANY OTHER PARTY.

Some states do not allow the exclusion or limitation of incidental or consequential damages so the 
above limitation or exclusion may not apply to you.

This license will be governed by the laws of the State of California as applied to transactions taking 
place wholly within California between California residents.

U.S. GOVERNMENT RIGHTS LEGEND

The program is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (OCT 1995), consisting of 
“commercial computer software” and “commercial computer software documentation,” as such terms 
are used in 48 C.F.R. 12.212 (SEPT 1995) and is provided to the U.S. Government only as a commercial 
end item. Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (JUNE 1995), 
all U.S. Government End Users acquire the program with only those rights set forth herein.
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Registration and 
Support

On the Web
The answers to most of the questions that you have about the BeOS and Be Inc. can be found at our 
web site:

http: / /www. be. com

Some locations within the web site that you may want to make a note of are:

http: / /www. be. com/users/registration. html

Go here to register your copy of the BeOS. Registering entitles you to discounts on future 
releases.

http: //www. be. com/support

The Support section provides customer service and technical support. You’ll find a wealth of 
Frequently Asked Questions (FAQs), software updates, documentation, and other information.

http ://www. be. com/support/assist

This is a list of links to other areas of the web site that can help you with customer service and 
technical support.

http: / /www. be. com/ support/assist/custsupport. html

This takes you to the Support Request form, which you use to request help on a specific topic.

http: // www. be. com/aboutbe/contactingbe. html

This is a list of other ways—web site locations, e-mail addresses, phone numbers—to contact Be.
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Through E-mail

Through E-mail
If you want to report a problem or have a question but you can’t get to the web, send e-mail to one of 
our support addresses. Please include as much information about the problem as possible, such as the 
configuration of your system, what you were doing, what happened, what you expected to have 
happen and why, and anything else about your configuration or problem that you think we should 
know.

For questions regarding installation, usage, configuration, and compatibility of the BeOS, BeBox, or 
other technical questions that are not about programming for the BeOS, send mail to:

custsupport @be. com

For questions about obtaining any of our products, send mail to:

custservices @ be. com

By Phone
If you’d prefer to speak to someone about the BeOS, you can call us. Our U.S. Support Center, which 
handles all BeOS support, is available Monday through Friday, between 6 am and 6 pm (Pacific time) at:

(972) 389-3740

By Post
If you’d like to write to us, send your letters to:

Be, Inc.
800 El Camino Real, Suite 400
Menlo Park, CA 94025

To write to our European offices, send to:

Be, Inc., Europe
Immeuble Le Linea
92047 Paris La Defense Cedex
France
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Introduction

This edition of the BeOS User’s Guide accompanies the BeOS ™ Release 4 and 4.5 for Intel, Power 
Macintosh, and BeBox. It includes these chapters:

Chapter 1, “BeOS Basics.” Explains the essentials of the BeOS user interface, including booting the 
system, the BeOS desktop, windows, and menus; the Deskbar and Tracker, Replicants, mounting 
disks, and system queries.

Chapter 2, “Be Application Basics.” Tells you about BeOS applications, and working with files and text.

Chapter 3, “Connecting to the Network.” Provides detailed information about configuring your BeOS 
system for networking.

Chapter 4, “Using Network Services.” Covers what you need to know about using Internet services 
with the BeOS, including the World Wide Web, the PoorMan web server, e-mail, and BeMail.

Chapter 5, “Customizing the BeOS.” Explains how to use BeOS preferences to customize the look and 
operation of your computer.

“Appendix A: The Mouse and Keyboard.” A guide to the mouse, keyboard, and keyboard shortcuts.

“Appendix B: Miscellaneous.” Summarizes screenshots and compressing, decompressing, and 
archiving files.

“Appendix C: The BeBox Guide.” BeBox-specific user information.

“Appendix D: Working with the Mac OS Tools.” Discusses working across platforms. Includes 
information on Macintosh TrueType fonts, and transferring files with Netfinder.

In addition to this guide, you can also refer to the following:

• Your computer’s owner’s guide. The owner’s guides show you how to set up the computer before 
you install the BeOS. They also include details about the computer’s ports and other features.

• The Installation Guide, which accompanies the BeOS CD-ROM, both as a printed booklet and as an 
electronic document on the Mac OS ™ portion of the BeOS CD-ROM.
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Keyboard Conventions Used in This Guide

• The Be Book, the reference to the Be API, is available in HTML format on the BeOS CD-ROM. The 
same information is also published in the Be Developer’s Guide, available from O’Reilly (ISBN: 1- 
56592-287-5).

• The Be World Wide Web site , for more information about Be, Inc., and the 
BeOS.

http://www.be.com/

• Specific information on installation and BeOS usage questions and answers can be found in the 
support section of the Be web site: .http://www.be.com/support/

• The Release Notes and other last minute documentation found on the BeOS CD.

Keyboard Conventions Used in This Guide
All keyboard references are based on the standard PC 104-key keyboard:

• AiFis the shortcut key

• Ctrl is the “other” key

• The Windows key is the option key

For complete information see “Appendix A: The Mouse and Keyboard.”

Text Conventions Used in This Guide
Different font styles are used in the text of this guide to make certain features easily identifiable:

• Applications, preferences, and window names: Tracker application, Network preferences, Query 
Result window

• Individual file and folder names and folder directory paths: /home folder, 
/boot/home/config/settings/ppp.

• Menu names or items in a menu: the File menu, the Print command

• User interface element: Add... a new network card interface, or Modify... or Remove an existing one

• Key names: press Ajt+O to open a file

• Glossary term: multihoming, network adaptor card

• Code (or computer voice): gzip f ile_name

• Links (URLs): http://www.be.com/support/
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1 BeOS Basics

This chapter shows you how to start up and shut down the BeOS, describes the fundamentals of the 
user interface, takes a look at the Deskbar and Tracker applications, and tells you how to search for 
files and folders. Chapter 2, “Be Application Basics,” begins where this one leaves off, covering the 
basic techniques you use with Be applications. Later chapters describe the applications that come with 
the BeOS.

This document assumes that you are familiar with the general operation and features of a computer at 
the user level—that you know what the mouse and keyboard do, what a window is, how to use a 
menu, and so on.

This chapter includes the following:

Section Page

Booting the BeOS page 18

Shutting Down the BeOS page 21

Getting to Know the BeOS Workspace page 23

A Look at BeOS Windows page 24

Working with Menus page 25

The Deskbar page 28

Working with the Tracker page 30

Replicants page 36

Finding Files and Folders page 37

Mounting Disks page 37

NOTE: The BeBox is supported for BeOS releases until January 1, 2000. For BeBox-related 
information not included in the main chapters of this guide, see “Appendix C: The BeBox 
Guide.”
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Booting the BeOS

Booting the BeOS
After installing the BeOS you’re ready to boot from your hard disk. (If you haven’t installed yet, see the 
installation booklet that came with your BeOS Release 4.5 CD.) Make sure there’s no CD with BeOS 
system software inserted in a drive connected to your computer, and then boot the BeOS:

• BeOS for Intel. Look for the BeOS Launcher icon on your Windows desktop (the BeOS installer 
copies it to your C: drive at C://BeLaunch/BeOSLauncher). Double-click the icon to launch the 
BeOS.

• BeOS for PowerPC. Double-click the BeOS_Launcher application (in the BeOS Mac Tools folder 
on the Macintosh hard disk, which you copied from the BeOS CD as described in the Installation 
Guide) or choose BeOS when the OS selection dialog appears during startup.

When you boot, the BeOS logo appears briefly as the computer starts to load the Be system software, 
including the Deskbar and Tracker applications. Together, Deskbar and Tracker serve as the BeOS 
file management and navigation tool, used for arranging and opening files, starting applications, and so 
on.

Booting on Intel
The Boot Loader is the all-purpose application for setting preferences and options at the start of the 
boot process. To get into the Boot Loader, press and quickly release the space bar when the BeOS 
splash screen appears. Use the arrow keys to highlight the different options in the Boot Loader, and the 
Enter key to select an option. The Boot Loader screen looks like this:

BeOS Release 4.5
Boot Loader

Select nev boot volume (Current: BeOS R4)
Select safe mode options
Select foil-safe video mode (Current: Default)

Continue booting

Selecting a Boot Volume

Select new boot volume is highlighted when the Boot Loader screen opens. If you want to change your 
boot volume from the current one that’s shown, press Enter and in the next screen use the arrow key to 
highlight Rescan for bootable partitions. If there are other bootable partitions, you’ll get a list to select 
from; if not, the current volume is highlighted and you should choose Return to main menu.
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Booting the BeOS

Booting Options

The sections that follow describe some Boot Loader options you can try if you have trouble booting.

Safe Mode Options

If you can’t boot, restart your system and go into the Boot Loader (press and quickly release the space 
bar). Highlight Select safe mode options, and press Enter. This brings up a menu, with Safe mode 
highlighted; pressing Enter selects Safe mode and all the other options in the list (except Enable console 
debugging, explained below). Return to the main menu and continue booting; your monitor will be in 
grayscale (if you’d prefer color see “Fail-safe Video Mode: Booting in Color with an Unsupported 
Graphics Card,” below). A dialog tells you that you’ve disabled “nonvital system services.”

Enable console debugging lets you see serial output for the initial part of the boot cycle. You’d choose 
this if you can’t boot and can’t troubleshoot the problem; you can read the serial output to a technical 
support person to help identify where in the boot process your system hangs.

o NOTE: Advanced safe mode options allows the entry of additional driver-specific options not 
included in the main Safe mode menu. Unless you know exactly what you’re doing you should 
not use Advanced Safe mode.

Fail-safe Video Mode: Booting in Color with an Unsupported Graphics Card

There are two scenarios for using Boot Loader’s Select fail-safe video mode:

• If your screen comes up in grayscale after a normal boot (that is, you haven’t checked Safe mode), 
you may have an unsupported graphics card. You can reboot, go into the Boot Loader (press the 
space bar quickly when the splash screen first appears), and choose Select fail-safe video mode to run 
in a color mode that’s not card specific.

• If you’re booting in Safe mode but want to view in color, choose Use fail-safe video mode from the 
Safe mode options menu, then return to the main menu and choose Select fail-safe video mode.

You’ll see a list of screen resolutions to choose from; pick one that’s reasonable for your moni­
tor—probably between 800x600x15 and 1024x768x16 (the numbers represent screen width x 
heights bits per pixel)', higher resolutions slow down your system. The first choice is Standard 
VGA, which is grayscale mode. After you choose a resolution, return to the main menu and con­
tinue booting. The result is slower than it would be if the BeOS had a driver for your card, but 
it’s faster than if you were running in grayscale, and you’ll probably like it better.

NOTE: Select fail-safe video mode may or may not appear in the Boot Loader, depending on your 
video card. If you have one of the newer, VESA-2 compliant cards you will see Select fail-safe 
video mode; with older cards you probably won’t.
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Booting the BeOS

Booting on PPC
You set the boot volume—your choice of a disk or partition to boot the BeOS from—during 
installation. There are two ways to change your boot volume after installation: by using the Boot 
preference application, or in the boot menu screen.

Boot Preference Application

The Boot preference app lets you select the volume from which you launch the BeOS. This is 
meaningful only if you have the BeOS installed on more than one partition. To learn how to use Boot, 
see “Setting the Boot Volume with the Boot Manager (Intel) or the Boot Preference (Mac/PPC)” in 
Chapter 5, “Customizing the BeOS.”

Boot Menu Screen

You can also change the boot volume in the boot menu screen. To see this screen, you need to 
interrupt the boot sequence by double-clicking the BeOS_Launcher and immediately holding down the 
Control key.

The boot menu screen looks like this:

BeOS Release 4.0 
Boot Loader

Volume Name 
BeOS R4

Location
(ide/ata/0/master/0/0_1)

Rescan for bootable volumes

Use f and + to select boot volume.
Press [enter] to boot.
Press 's' to enter safe mode.

The screen lists each bootable volume by its device name and by its volume name. Use the arrow keys 
to select a boot disk and press Enter to make the selection take effect. The boot process then 
continues.

Troubleshooting: Booting in Safe Mode

If you’re having trouble booting it may be because your other hardware (network card, sound card, 
modem, and so on) is not supported by the BeOS. You may be able to work around the problem by 
trying a “safe boot”:
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• First, bring up the boot menu screen, as explained above.

• Highlight the volume you want to boot and press “s” to toggle into safe mode.

• You’ll see a list of items with checkboxes.

• The only item you should check is the first one, Safe mode. Press Enter to check the option.

• To continue with the boot sequence, use the arrow keys to highlight
Continue safebootinq from “diskname” and then press Enter. If you want to return to the boot menu 
screen, highlight Cancel and press Enter.

After the BeOS is booted, a panel with further instructions will be displayed. If you still have trouble, 
send e-mail to BeOS Customer Support: custsupport@be.com.

Shutting Down the BeOS
Before you turn off the computer you should shut down the BeOS to give applications a chance to 
clean up after themselves.

1. Save files you are currently working in.

2. Click on the Be logo in the Deskbar to bring up the Be Menu, then choose Shut Down or Restart.

3. If there are tasks in progress (copying or moving files, emptying the trash, etc.), a dialog asks you 
to confirm shut down/restart when they are complete.

4. Eventually, you’ll see a message that it’s safe to turn off the computer, or click the Reboot System 
button. If you want to reboot immediately press Enter to restart the BeOS. (If you chose Restart, 
this message does not appear.)

System is Shutdown !

It'® now safe to turn off the computer.

Reboot System
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The Team Monitor
If an application or server is causing 
problems, but the trouble falls short of a 
system crash, you can use the Team Monitor 
to kill a single, troublesome application or 
server without having to reboot. For 
example, if an application freezes, press 
Control+Alt+Delete (the Del key on the numeric 
keypad or the Delete key above the arrow 
keys) to bring up a selection window that 
shows all currently running apps and servers. 
Highlight the application you want to kill 
(only applications and servers that are 
currently running appear in the selection 
window), and press Kill, then press Cancel 
(you must cancel the Team Monitor window 
to continue working). If killing one or more

Team Monitor j

| Cancel

apps or servers doesn’t free up your system, press Control+Alt+Delete again to forcibly reboot.

Resetting the BeOS
If your computer crashes, you’ll need to restart or “reset” the BeOS:

• BeOS for Intel. Press Control+Ait+Delete (the~Del key on the numeric keypad or the Delete key above 
the arrow keys).

• BeOS for PPC. Press Control+Command+Power On.

• Ona BeBox (or other hardware). Press the Reset and Interrupt buttons. Check your computer’s 
user manual for the location of these buttons.

<=> CAUTION: If you reset the computer without choosing Restart or Shut Down first, you risk losing 
data. In particular, you’ll lose changes made to documents since you last saved them.
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Getting to Know the BeOS Workspace
Familiarize yourself with the Be workspace as it appears in this screen:

Appearing on the desktop when you boot the BeOS:

• An icon that represents the BeOS partition that you installed on your hard drive. This is where the 
Be file system lives.

• An icon representing the Windows or Mac partition of your hard drive. You can read and write the 
files on this “foreign” partition, but you can’t run Windows or Mac applications.

• A link to your home folder. This contains, among other things, a query folder for system queries 
you generate with the Find feature, a mail folder, and a SampleMedia folder with test files to use 
with applications.

• Welcome_To_BeOS.html is a link to the online documentation.

• The Trash icon. This is where you drag files that you want to dispose of.

• The Deskbar, which is explained in its own section below.

Like most operating systems, the BeOS presents documents (and other data) in windows, and lets you 
operate on the data through direct manipulation (typing, cut/copy/paste, etc.) and through the use of 
menus. Before looking at specific parts of the BeOS, such as the Deskbar and Tracker, we’ll glance at 
how windows and menus look and behave on the BeOS.
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A Look at BeOS Windows
The windows that the BeOS presents are similar to those of other operating systems. For one thing, 
they’re square. And you can move them, resize them, close them (and so on), using techniques that 
should be familiar to anyone who’s touched a computer in the last ten years. This section provides a 
very brief look at a typical BeOS window, and tells you how to manipulate it.

Be windows look like this:

window tab

close button

border

scroll arrows

scroll bar

resize area

• Moving and Resizing. To move a window, drag it by its tab or 
border. To resize it, grab the resize area and drag. On 
windows that have scroll bars, the resize area is the square 
between the scroll bars (as shown above); on other windows, 
it’s simply part of the window’s border.

— resize border

• Zooming. You can also resize a window by clicking its zoom button. This resizes the window so 
it’s big enough to display everything it contains (without spilling off the screen). Click the zoom 
button again to return the window to its previous size and location.

• Hiding and unhiding. To hide a window, double-click its window tab anywhere except in the 
close or zoom button. When a window is hidden, its icon in the application’s Window List (in 
Deskbar) is gray; to unhide the window, click on the grayed-out icon. (The Window List is 
described and illustrated later in the “The Deskbar,” later in this chapter.)

• Closing. You close a window by clicking the close button. For most applications, closing the app’s 
final window automatically quits the app.
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• Sliding the window tab. A unique feature of Be 
windows is that you can slide the window tab 
across the top of the window. You do this by 
holding down the Shift key and then dragging the 
tab.

The BeOS has a notion of an active window. Many 
windows can be open but only one window can 

shift drag slides the window tab

respond to your actions, such as pressing keys on the keyboard. This active window is the one that’s 
frontmost on your screen and has a yellow tab. (The tabs of all other windows are gray.) To make a 
window active, click its tab, border, or, for most windows, anywhere inside it. When you start up a 
new application or switch applications, the frontmost window in the new application is usually the 
active window.

NOTE: If you’ve used the Mouse preference to turn on Focus follows mouse, the active window 
will be whatever window the mouse is pointing to. In focus-follows-mouse mode, the active 
window may not be frontmost, but it will have a yellow tab.

Working with Menus
Menus are pop open palettes of commands. BeOS menus aren’t much different from menus on other 
operating systems—if you’ve used a computer before, you shouldn’t have any trouble using the Be 
menus.

This section describes the default look and behavior of Be menus. To customize the menus on your 
computer, see the “Menu” in Chapter 5, “Customizing the BeOS.”
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Windows and Menu Bars
Almost all 
windows have a 
menu bar, a grey 
bar at the top of 
the window that 
contains some 
number of menu 
titles. Click on a 
title and the menu 
it corresponds to 
pops open, 
displaying its 
commands. An

menu bar

menu titles

Terminal Edit

Terminal 1

elcome to the

$

Settings

menu arrow

Window Size
Font
Font Size...
Character Encoding 
lab Width...
Color...

Save as Defaults
Save as Settings Fil^T}

submenu

80x24
80x25
80x40
132x24
132x25

ellipsis

arrow to the right of a command indicates a submenu. If a command title has an ellipsis at the 
end, it indicates that if you choose the command, an additional panel will appear

To select a command from a menu, simply click on it—the command is executed and the menus go 
away. To dismiss a menu without choosing anything, hit Escape. If you have submenus open, you 
have to hit Escape for each one.

The menu shown above was opened by clicking (i.e., pressing and releasing the mouse). You can also 
drag through a menu: Press on a menu title and drag through the menu, releasing the mouse when it’s 
pointing to the command that you want. Submenus automatically open and close as you drag over 
them. To dismiss the menu(s) without choosing a command, simply drag the mouse outside the 
bounds of the menu and release.
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Context Menus
Many items that appear on the desktop and in Be 
applications have context menus associated with 
them. A context menu is an object-specific menu 
that’s displayed when you press (mouse-and-hold) 
on the object; it takes a moment for the menu to 
appear—long enough for the system to realize that 
you’re not going to double-click the object. You 
can pop open a context menu immediately by 
pressing with the second mouse button, or by 
holding down Control+Ait when you press with any 
button.

An object that has a context menu doesn’t give you 
any visual indication that the menu exists—you 
learn which ones do mostly by experience. Most 
objects presented by Tracker and Deskbar do have 
context menus. For example, if you press a file icon 
inside a Tracker window, you’ll see the context 
menu shown here.

beos

File Window

system

items

preferences

6

Shortcuts and Triggers
BeOS menus can also be operated from the keyboard, through shortcut keys and trigger letters.

• A shortcut key is an letter combination that’s assigned to a 
specific menu command (or, on a Macintosh-based machine, 
Command + letter). Some shortcuts specify additional modifier 
keys, such as Shift or Control. Pressing the keyboard shortcut 
when the menu is closed chooses that command. The 
shortcuts for a menu’s command are shown along the right 
side of the open menu. Not every command needs to have a shortcut keys

Open Alt O
Open With... Ctl Alt O O
Get Info A«j 1
Edit Name ALT E

Duplicate ALT D

Move to Trash ALT T

shortcut. Keep in mind that the shortcuts only work when the menu is closed.

• A trigger letter is a single character that’s assigned to a 
command. By pressing a trigger letter, you invoke the 
associated command. Trigger letters are underlined in a menu’s 
title or in a menu item, and only work when the menu is open.

Some aspects of a menu’s look and behavior can be modified 
through the Menu preference.

Font >
Font Size...
Character Encoding >
Tab Width...
Color...

trigger letters
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The Deskbar
The Deskbar is a roster of system services and applications. It contains Be Menu items, the Status View, 
and a list of all running applications. When you start the BeOS, the Deskbar appears in the upper-right 
corner of the screen. To move it to any of the four corners or to spread it across the top or bottom of 
the screen, grab the dotted border at the right of Status View. This is easier to see than to describe:

expanded Deskbar compact Deskbar
the blackboard icon 
represents the Application 
List when the Deskbar 
is compact

grab this dotted line 
with your mouse to 
expand and compact 
the Deskbar

When it’s lying along a side of the screen (as opposed to spread across the top or bottom), the Deskbar 
can appear expanded (the default) or compact. To compact the Deskbar, press the dotted line and 
drag up. When the Deskbar is compact, a blackboard icon next to the Be Menu represents the 
Application List. Clicking on the blackboard pops open the list of running applications.

The Be Menu
The Be Menu opens when you click the Be logo in the Deskbar. The Be Menu contains:

• About BeOS. Basic system information and credits.

• Find. The system query application, described in 
detail in “Finding Files and Folders” in this chapter.

• Show/Hide Replicants. The replicants mechanism 
lets you “clone” views and drop them into other 
applications. The Show/Hide Replicants menu item 
displays or hides the replicant’s handles, or 
draggers. See “Replicants” in this chapter for more 
information.

• Restart/Shut Down. These were described in “Booting the BeOS,” above.

• The folders listed at the bottom of the Be Menu comprise the “shortcut” list—folders and files that 
you want to keep at your fingertips. By default, the list contains the apps, preferences, and
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demos folders. You can add your own items to this list, as explained in the chapter “Customizing 
the BeOS.”

Status View
The Status View initially shows the time. Click on the time and it 
changes to the date. (To set the Time preference, see “Time (and 
Date)” in Chapter 5, “Customizing the BeOS.”)

2:27 PM

Status View

Be

New Message

Open Mailbox
Open Mail Folder

Check Now

Certain system services add icons to the Status View to tell you that 
they’re running, and to give you access to their menus. For example, 
the mailbox icon shown above is added by the mail daemon (the 
background service that sends and delivers e-mail). Clicking on the 
mailbox icon pops up a list of mail commands (the commands 
themselves are explained in a later chapter).

The Application List
The Application List shows all currently running applications. The application is always visible in 
Deskbar’s expanded form; when Deskbar is contracted, you pop open the list by clicking the 
blackboard icon. Clicking on an application in the list “activates” that application and brings one of its 
windows to the front of the screen.

Each application has its own Window 
List which you can see by clicking 
and holding the app’s icon. The 
Window List lets you select individual 
windows, and also lets you show, 
hide, and close all windows in an 
application

Windows that are hidden are grayed 
out; click on the gray icon to make 
the window reappear on the desktop. 
“Speedlines” next to a window icon 
indicate that the window is in a 
different workspace than the current
one; clicking on the icon takes you to that workspace.
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Working with the Tracker
The Tracker application is the BeOS file system navigation and file management interface. Tracker 
windows present the contents of individual folders. The next sections explain how Tracker windows 
are set up (“Looking at Tracker Windows”), how to use the windows to navigate the file system 
(“Navigating in Tracker Windows”), and explores some of the things that Tracker lets you do to files 
and folders (“Tracker Basics”).

Looking at Tracker Windows
When you double-click a folder, a new Tracker 
window opens on the screen. The window can display 
its contents—the files and folders it contains—as icons, 
mini-icons, or as a “list view.” You change modes by 
choosing an option from the Window menu.

Icon and Mini Icon View

In Icon View and Mini Icon View, you can move an icon 
within the window by dragging it to the location you 
want. If more than one icon is selected, they all move 
when you drag.

Some of the commands in the Window menu arrange 
the icons in a grid. Choose Clean Up to align each icon

File

.profik

V Icon View
Mini Icon View
List View

BDT

ho me Window menu

Window

Rlt Y
= tgz Bas

Resize to Fit 
Clean Up 
Select All 
Open Parent 
Close

Jme
ALT f

67 items

<

in the window to the nearest location in the grid. If you hold down the Shift key, Clean Up changes to
Clean Up All, which sorts the icons in the window in alphabetical order.
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List View

In List View mode, the Tracker window 
displays its contents in a vertical list, and 
additional facts, or attributes, are given for 
each item. The names of the attributes are 
listed in the window’s attribute bar.

The window displays an Attributes menu. 
This menu lets you select the attributes you 
want to display. The full list of attributes 
depends on the type of files the window 
contains, but some common attributes 
(name, size, modification date) are 
available to all files. You can also pop

apps attribute bar

File Window Attributes
Name size | Modified ------ £
BeMail 329.54 KB Fri, Oct 09 1998, 02: 3
CDPlayer 236.11KB Fri. Oct 09 1998, 02:

a Clock 133.91 KB Fri, Oct 09 1998, 02:

Connect 293.54 KB Fri, Oct 09 1998, 02:

o DiskProbe 220.21 KB Fri, Oct 09 1998, 02: A
Expander 181.58 KE: Fri. Oct 09 1998, 02: v

21 items ________

open a copy of the Attributes menu by right-clicking in the attribute bar.

File Window
I Name

£ Terminal

StyledEdit

F SimpleMidi

Showlm...* SCSIProbe

Pulse

Attributes menu

Attributes

VName
VSize
V Modified 

Created 
Kind
Path

(modified | A

=ri. Oct 09 1998, 02:5*

=ri. Oct 09 1998, 02:5*

=ri, Oct 09 1998, 02:5C"

=ri, Oct 09 1998, 02:5C

AQ -IQQO AORf

112.11 KB Fri, Oct 09 1998, 02:5*

Moving and Resizing Attribute Columns

To change the order of the 
attributes, click on an attribute 
in the attribute bar and drag it 
to another location. You can 
resize an attribute’s column by 
pressing and dragging the 
divider between two of them 
and dragging to the size you 
want. A special cursor and a 
blue line indicate that you’re in 
resize mode.

To move an attribute drag it where you want it; drag it out of the attribute bar to remove it.
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Sort Order

Initially, items in List View are sorted alphabetically by name—in attribute-speak, the “name” attribute is 
the primary sort field. If you click on an attribute it becomes the primary sort field and the items in the 
list are sorted accordingly. Also, the attribute you clicked is now underlined. To set a secondary sort 
field, Shift+click on another attribute. A dotted underline indicates the secondary field. Click a second 
time on either attribute to sort in reverse order.

apps
Mkmk J

primary File Window Attributes secondary 
___ sort fieldson iieia

(solid line) (dotted line)MiniPlayer Fri, Oct 09 1998, 04:29:09 PM /boot/apps/
® NetPositiye Fri, Oct 09 1998, 04:29:09 PM /boct/apps/

People Fri, Oct 09 1998,04:29:09 PM /boct/apps/

PlaySound Fri, Oct 09 1998, 04:29:09 PM /bcct/apps/

PoorMan Fri, Oct 09 1998, 04:29:09 PM /boot/apps/

V

Navigating in Tracker Windows
Like most modern operating systems, the BeOS is based on a hierarchical file system that uses the 
metaphor of folders (or directories) to help you organize and keep track of your files. Within the 
hierarchy, every folder has a parent folder. There are three ways to open the parent of the Tracker 
window that you’re currently working in:

• By choosing Open Parent from the Window menu.

• By pressing Alt+up arrow?

• By using the path popup, as described below.

Click the lower-left edge of a folder window (the 
area that shows the number of items the folder 
contains). This displays the path popup, a list that 
describes the succession of nested folders—the 
“parent path”—to your current folder. You can 
open any folder from the path popup by selecting 
it.

If you hold down the Windows key when opening 
a parent folder, the original folder closes when the 
parent opens.

You can “descend” the file hierarchy simply by 
double-clicking a folder within your current 
Tracker window. This opens a new window for 

. J servers

--------path pop-up

system

OBeOSR4

Desktop
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the “child” folder, in which you can double-click another folder, and so on. Again, if you hold down 
the Windows key while opening a new Tracker window, the old window closes.

You can also descend the hierarchy by using the context menu that pops open when you press and 
hold the mouse on a folder icon. The context menu shows the standard File menu commands, plus, at 
the top of the menu, an item that represents the folder that you pressed the mouse on. Move the 
mouse over the item and another menu appears that shows the folder’s contents. You can select a file 
or folder in this menu, or descend some more by moving your mouse over yet another folder, and so 
on.

BeOS R4

File Window Attribute::-:

B
7

12 iter

Open
Open With...
Get Info
Edit Name
Duplicate 
Move to Trash

Alt o
CTL ALT: O

Alt E

ALT T

apps

C/ documentation

preferences 
s system

[> About_The_Demo_Apps.html

Move to 
Copy to 
Create Link

Identify
Add-Ons

Be Book

Be_Developer_Resource3.html
V7 BeOS_Product Jnformation

BeOS Software.html
Q graphics

> index.html

Q Pressinfo 

‘kJ* Release_Notes
Cj1 Shell Tools

The Media Kit
G The Be FAQs

[>

o 
o 
o

[>

For information on keyboard navigation of Tracker windows, see “Keyboard Shortcuts” in “Appendix 
A: The Mouse and Keyboard.”

Tracker Basics
Some of this information will already be familiar to you from other operating systems, but some is 
BeOS-specific.

Getting Information About an Item

To get information about an item in a Tracker window, select it and choose Get Info from the File 
menu. Most context menus also have a Get Info command.
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The information you receive depends on the item: Disk information is about storage capacity and free 
space. File information is about size, creation, modification date, and location in the file system. For 
applications, you get this same information, plus a version number.

Renaming Items

To rename an item in a Tracker window, click on the name and type, or select the item and choose 
Edit Name from the File menu. You can use up to 255 characters—anything but a forward slash (“/”)— 
and any name not already used in that folder.

If you change your mind about renaming a file or folder while editing its name, press the Escape key to 
restore the original name.

WARNING: Do NOT rename the /beos folder located on the boot disk or the BeOS will no 
longer work.

Moving, Copying, and Linking

You can move items from one folder to another by dragging them into the window or onto the icon of 
the destination folder.

NOTE: If the destination folder is on a different volume, the item is copied instead of moved.

If you want to copy an item rather than move it, hold down the Windows key while you drag the item. 
This forces a copy whether the destination is on the same volume or not. You can also copy an item 
(into the same folder) by selecting it and choosing Duplicate from the window’s File menu. The 
duplicate has the same name as the original, but with “copy” appended. If you make multiple copies 
of the same item, “copy 2,” “copy 3,” etc., is added to the name.

If you hold down the Control key when you’re dragging a file or folder 
icon, you’ll see the file options menu. Choose from one of the options 
to create a link to (which we’ll explain in a moment), move, or copy 
the file (or cancel).

file options menu

Create Link Here
Move Here
Copy Here

Cancel
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The context menu that you get when you press and hold on an icon presents a similar array of file 
options. In addition, it lets you navigate the file hierarchy to search for the destination folder at the
same time.

Midi

MiniPlayer

People

PlaySounc

21 items

context menu 
file options -

Fi i. Oct 09 1998, 04:29:09 PM

Fri, Oct 09 1998, 04:29:09 PM M

JExLjQiiLjQSL-1998, 04:29:09 PM

?8, 04:29:09 PM

J8. 04:29:09 PM

Create Link

Move to
Copy to

Identify
Add-Ons

Open
Open With...
Get Info
Edit Name
Duplicate 
Move to Trash

M E
Rlt D
Rlt T

Rlt. O
CTL RLT; O >

II!

O BeOS R4

home

New Folder

Trash

Welcome_.To_BeOS.html

windows

M apps 

beos
Q1 demos 

kJ" develop 

CJ home 

yj? preferences

o 
o
J> 
[>

If you’re copying or moving a lot of files, a Status window shows the progress of the task. You can 
click the Stop button to stop a task in midstream, but whatever you’ve done so far is not undone.

Creating a Link

A link is a “dummy” file that points to an actual file or folder. The link file 
displays the same icon that represents the real item. To show that it’s a link, 
the link’s filename is underlined. A link is a handy way to create a shortcut to a 
file, folder, or application that you frequently use. You can put a link 
anywhere, but they often live on the desktop.

home

this is a link

Deleting Items

You delete files, folders, and other items by dragging them into the 
Trash. You can also choose Move to Trash from the File menu or 
from object’s context menu. You can also highlight an item and 
press the Delete key (not the backspace key). When the Trash can 
isn’t empty, it displays rubbish.

empty 
Trash can

non-empty 
Trash can

Trash Trash

Items in the trash aren’t actually deleted until you empty the trash.
If you decide not to delete something, double-click the Trash icon and drag it out of the Trash window 
that opens up.
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When you want to remove items permanently, choose the Empty Trash command from the File menu in 
the Trash window, or from the Trash icon’s context menu. You should empty the trash periodically, 
because eventually it can take up a lot of disk space.

Tracker Add-ons
Add-ons are applications that can perform operations on individual files or on a set of files; they’re a 
way of adding things to a program that weren’t included when it was written. Three types of Tracker 
add-ons come preinstalled with the BeOS: Backgrounds, FileTypes (both explained in this guide’s 
chapter on preferences, “Customizing the BeOS”), and Zip-O-Matic.

Zip-O-Matic

Zip-O-Matic lets you compress and archive multiple files into a single file (it replaces MakeArchive). To 
use Zip-O-Matic, highlight the files or folders you want to compress and right-click to open a context 
menu, then highlight Add-Ons (at the bottom of the menu) and click Zip-O-Matic; a status window 
shows the progress of creating the archive.

You can also use Zip-O-Matic by right-clicking on the desktop to bring up context menu, then 
choosing Add-ons>Zip-0-Matic. A Zip-O-Matic window pops up that tells you to drag the files onto 
it that you want to zip.

There are also many third-party Tracker add-ons (along with third-party application add-ons) available 
from BeWare (http://www.be.com/beware/Add-Ons.html) for doing such things as viewing archives, 
expanding and compressing files, viewing file attributes, searching file contents, and so on.

Replicants
A replicant is a component of an application that you can “clone” so that it resides inside another 
application. To replicate an item, open the Be Menu in the Deskbar and choose Show Replicants. This 
creates hand-like draggers on items you can replicate. Grab by the dragger to place the replicant 
anywhere you want, including the desktop.
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Replicant

Draggers

Currently, you can replicate the Clock application and NetPositive web pages. For more on web page 
replicants, see “NetPositive as a Replicant—Live Desktop Pages” in the chapter “Using Network 
Services.”

To delete a replicant, right-click on the dragger; a popup menu gives you the option to delete.

Mounting Disks
Mounting disks makes their contents available to the operating system. Use the Mount command in the 
desktop context menu or in the context menu that appears when you press on the icon of any 
mounted volume. In both context menus, all available disks appear in the Mount menu popup; disks 
that are already mounted have a checkmark beside them. Both menus also give you the option of 
mounting all attached disks with the All Disks command.

If you click Settings, you’ll see the Disk Mount Settings panel, which lets you specify automounter 
settings—which disks you want mounted on your desktop.

Finding Files and Folders
You use the Find command in the Be Menu to search for files, folders, and other items in the Be file 
system. You can also search for such things as e-mail or the names of audio CD tracks you enter in the 
CDPlayer application.
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When you choose Find, the Find panel opens; there you specify the attributes of the thing you’re 
looking for.

The Find panel shown here is prepared to search for any file or folder that has the word “screen” in its 
name. The search is performed on all disks (including Mac or Windows volumes). Click the Search 
button and a window opens and starts to fill with items.

Name = screen ■ Oct 19,10 20 16 AM

/boot/exp/src/kit/interface/obj.i586.dyr

File Window Attributes
1 Path A

GSu.ll / boot/ exp? src/Inc? Inter1tace_p? 7

/boot/exp/src/kit/interface/

/boot/exp/src/apps/rraster/

PrivateScreen.c

SaveScreen.cpp

SaveScreen.h

SaveScreen.h /boot/exp/src/kit/interface/

/boot/exp/8rc/kit/interfaoe/obj.i586.dyr

<3 screen

Screen

/' Screen

171 items |^|O|

/boot/exp/src/preferences/ 

/boot/exp/src/preferences/screen/obj.

£/boot/exp/src/toote/'t . ..s/ezmatrix/docs

/omma/Vnur W Ret Pi . ormatriv/rinr-i

As shown here, the window (a Query Result window) looks a lot like a Tracker window, except the 
background is gray, and it only works in List View. (In fact, the window is created by Tracker.) You 
can double-click the files and folders that are listed in the window, move them, copy them—you can 
do just about anything you would do in a “normal” Tracker window.

The Find panel lets you modify your search, or query, in these ways:

• The top-left popup lets you choose the type of item you want to find (“All files and folders,” “E- 
mail,” “Bookmark,” etc.)

• The center popup lets you choose one of three search techniques: You can search by name, by 
attribute, or by formula. The attribute search is the most powerful—it lets you ask for files of a 
certain age, size, and so on. The formula search, in which you type in a logical expression (such as 
name^screen*’*) is the most flexible, but is also the clumsiest and hardest to understand.

• The right popup lets you restrict your search to a particular volume.
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Toggle the Find panel’s little grey arrowhead, and you’ll see more choices.

• The Query name: field lets you name the query that you’re creating so you can run it again later. 
You don’t have to name your queries—usually you only do this for queries that you run by habit. 
For example, if you regularly check your disk for large files, or for e-mail of a certain age (so you 
can prune it), you would want to name these queries.

• The Include trash checkbox tells the Find mechanism to rummage through the Trash can. By default 
it avoids that rubbish.

• Checking the Temporary check box means your search results will be saved only for a certain system­
set period of time. If you want to save your query uncheck Temporary.

Saving and Editing Queries
Queries are saved as files in the home/queries folder, either under the names that you gave them, or 
using the default names that the query mechanism gives them. When you double-click a query file, the 
query is re-run—it’s as if you opened the Find panel, typed in the query criteria, and hit Search.

To edit a query, select a query file in the home/queries window and select Edit Query from the File 
menu (Alt+G). This brings up the Find panel that’s filled in with the query’s criteria; you can then 
change the criteria. The Query Result window also has an Edit Query item in its File menu. This lets 
you bring back the Find panel for a query that you’ve just run.

To delete a query, drag it into the trash, just like any other file.
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2 Be Application 
Basics

This chapter introduces the techniques you use when working with the applications that Be supplies. 
Many of these techniques, such as how you launch and quit an app, or how you open and save files, 
can be applied to third-party applications, as well. Native BeOS applications are in the /apps folder 
located on your boot volume. As a convenience, the folder is included in Deskbar’s Be Menu, as 
explained in “The Deskbar,” in Chapter 1, “BeOS Basics.” For some specific information on 
applications that are new or modified in Release 4.5 see the User Release Notes on your BeOS Release 
4.5 CD (/boot/beos/documentation/User's Guide/Release Notes/index.html).

This chapter contains:

Section Page

Working with BeOS Applications page 41

Working with Files page 43

Working with Text page 45

Working with BeOS Applications
Here’s how you launch, switch between, and quit applications. Keep in mind that because the BeOS is 
multitasking, you can run many applications at the same time.

Launching an Application
The obvious ways to start an application are by (a) double-clicking its icon, (b) selecting the icon (in a 
Tracker window) and choosing Open from the File menu, or (c) selecting the icon and pressing Enter.
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You can also launch an application by opening a file: Opening a file automatically launches the 
preferred app for that file. (To set the preferred app use FileTypes, explained in “FileTypes” in the 
chapter “Customizing the BeOS.”)

When an application is running, its name is added to the Application List in the Deskbar. When you 
select an app in the Application List, you can see its open and hidden windows as explained in “The 
Application List” in “Be Application Basics.”

The Active Application and Switching Apps
While all running applications are “active,” in the sense that they can all be doing work at the same 
time, the application in the frontmost window (with the yellow tab) is referred to as the active 
application, and responds to keyboard actions.

The exception to the active window being frontmost occurs if you check the Focus Follows Mouse 
checkbox in the Mouse preferences panel. In that case, the active window is the one the mouse 
is pointing to, whether it’s frontmost or not. For more information see “Mouse” in the chapter 
“Customizing the BeOS.”

Switching Between Applications

You can switch easily between applications by clicking in an open window belonging to the 
application you want to switch to. In addition, you can use the Deskbar’s Application List or you can 
use the Twitcher application, as explained below.

The Twitcher

Twitcher lets you see and switch between running applications and their windows. To bring up the
Twitcher, press and hold Control, and then press and release Tab. The Twitcher window looks like this:

With Control still held down, successive Tabs (or left/right arrows) will cycle through your open 
applications. The up/down arrows will cycle through an app’s windows. To switch to the app (and 
window therein) that Twitcher is pointing to, simply release the Control key. The application’s window 
comes to the front on your desktop; if the window is in another workspace, you’re taken to that 
workspace.
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Quitting an Application

To quit an application, you can (a) choose the Quit menu command, generally found in the File menu, 
(b) type Ait+Q. the shortcut key for Quit, or (c) close the app’s last open window—most applications are 
designed to quit when all their windows have been closed. If you’re running a full-screen application 
such as the Dominoes demo or many games, pressing Ait+Q is the only way to quit.

Working with Files
If you’ve ever turned on a computer, chances are you already know how to open a file, create a new 
one, save it, and close it. Here’s some additional information for handling files in the BeOS.

The “Open With” Window
When you open a file, the application that’s designated as the file’s preferred application is told to 
display the file’s contents. However, there are times when you may want to use some other application 
to view the file. To get a list of candidate applications, select a file in a Tracker window and choose 
the Open With command in the File menu. An Open With window is displayed that shows all the 
applications the system thinks it can use to open the file.

Open Valerie Peyre With:

relation 1: the preferred app

relation 2: specific handlers

relation 3: generic handlers

relation 4: wildcard apps

The applications are divided into four “relations,” by their aptness for opening the file: 

• The first relation always contains the preferred application (only).
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• The second relation shows all applications that handle the file’s “specific” type.

• The third relation shows applications that know how to handle the file’s generic type. Examples 
would be video applications that open any MPEG file, or applications that open any type of text file, 
whether the text is in a word processing file or source code file.

• The fourth relation are wildcard applications that will try to open any file.

If you select an application other than the preferred one, the Open and Make Preferred button becomes 
live. This button makes the application you choose the preferred app to open this file and all other 
files of the same type. Selecting an app in the list and choosing Open uses the chosen app without 
changing the identity of the preferred application.

NOTE: If the system can’t identify the type of file you’re trying to open, the Open With window 
will list all applications, and list as them as “Does not handle file.” If you choose one of these 
apps, an overly cautious dialog warns you that the application you’ve selected to open your file 
doesn’t support the file.

You can also get to the Open With list by popping open a file’s context menu. The four relations are 
divided graphically:

File Wi utes
A

Jim Thompson V2I39

Open Rlt O

144 its

Get jnfo
Edit Name 
Duplicate 
Move to Trash

ALT D

V* /boot/beos/apps/BeMail
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Move to
Copy to
Create Link

Identify
Add-Ons

UjJ /boot/beos/ap. ..rowerks/BelDE 

/boot/apps/Metrowerks/BelDE 

/boot/home/apps/eddie/Eddie
® /boot/beos/apps/NetPositive 

4^ /boot/beos/apps/StyledEdit
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/boot/beos/pr...nces/FileTypes

preferred app

relation 2
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Opening a File by Dragging and Dropping
You can drag a file onto an application icon to open it in that application. If the application is able to 
open the file, its icon is highlighted. Drag and drop is a good way to open a file in an application that 
isn’t the preferred app, because it doesn’t reset the preferred app. For example, let’s say you want to 
edit an HTML document. Rather than double-click the icon, which would launch NetPositive, you 
would drop it onto the StyledEdit application.

When you drag a file and hold it over an app that doesn’t know how to open the file, the app’s icon 
doesn’t highlight, and the app won’t open the file. To force the app to accept the file, hold down the 
Control key when you drop the file icon.

Working with Text
The following sections summarize working with text on the BeOS.

Selecting and Editing Text
You select text to change it or to edit it in some arrangement of the Cut, Copy, and Paste commands. 
For information on mouse and keyboard shortcuts see “Text Selection and Editing Shortcuts” in 
“Appendix A: The Mouse and Keyboard.”

Deleting Text

The simplest way to delete text is to press the Backspace key (located at the right end of the number 
row on the keyboard), which erases text to the left of the insertion point, character by character. 
(Depending on the keyboard you’re using, the Backspace key may be labeled “Delete,” “Backspace,” or 
may have a left-pointing arrow.) A second Delete key, which in the extended keyboard is located 
between the letter section and the number keypad and above the directional arrows, erases text to the 
right.

Clippings
Clippings is a BeOS feature that lets you make a persistent file of text that you drag out of an open 
document. You create a clipping file by selecting text and dragging it to the desktop, where it appears 
as a file named “Clipping from filename ” where filename is the name of the file that the text was 
dragged from. You can drag the clipping file into any text editor application that accepts drag and 
drop. What happens when you do this depends on the application you drop the clipping file into. If 
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you drop it into a StyledEdit window, it appears as the original selected text; if you drop it into a 
Terminal window you’ll see the directory path to the clipping file.

To delete a clipping, drag its icon to the trash.
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3 Connecting to the 
Network

This chapter explains how to set up your computer so it can access the Internet in either of two ways. 
It also explains how to set up your computer to work in a stand alone network.

This chapter covers the following topics:

Section Page

Before You Start page 47

Connecting to the Internet page 49

Network Preferences page 49

Setting Up a Stand Alone Network page 53

Dial-up Networking: Connecting by Modem page 55

Setting Up BeOS for Both Stand Alone Network and 
Modem-Based Internet Use

page 57

Before You Start
This section lists the network hardware that’s recognized by the BeOS, and defines some of the terms 
that are used throughout this document.
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Hardware
To connect to a network, you need a network adaptor card. This is the card that you plug into your 
computer, and to which you connect your Ethernet or modem cable. The BeOS supports the following 
cards:

• PCI Network Adapter Card. These cards are inserted into one of the PCI slots on your computer.

— DEC 21040/21041-compatible cards
— 3COM EtherLink XL (3C900, 3C905, 3C905B)
— Intel EtherExpress (Intel only)

• ISA Network Adapter Card. These cards plug into the ISA slots of Intel-based and BeBox 
systems.

— NE2000-compatible cards for Intel and BeBox
— 3COM EtherLink Il-compatible cards for BeBox

• Power Macintosh On-Board Networking. This comes bundled with Power Macintosh­
compatible computers that have built-in Ethernet networking.

BeOS does not currently support software modems or PCI modems. BeOS for Power Mac supports 
external modems only. BeOS for Intel supports both internal and external modems.

For the most up-to-date list of hardware that’s compatible with the BeOS, go to
<http ://www. be. com/support/>.

Terms
The following terms are used throughout this chapter. Although you don’t need to know precisely 
what they mean, you should at least be familiar with the ballpark they play in.

• Internet Service Provider (ISP). An ISP is a company that provides access to the Internet. 
Typically, the ISP lets your computer access the World Wide Web and provides e-mail services.

• Internet Protocol (IP) address. An IP address is a set of four numbers, each ranging from zero 
to 255, separated by periods; for example, 192.168.0.67. Every computer connected to the 
Internet must have a unique IP address.

• Host name and domain name. A host name and domain name are, taken together, a human- 
readable version of your IP address. The host name is the name of your computer; the domain 
name identifies the company, ISP, or other organization that your computer is “attached” to. For 
example, in the name . com, “fido” is the name of a computer within the domain “be.com”.fido.be

• Domain Name Server (DNS). A DNS is a computer that knows how to convert IP addresses into 
host/domain names. If there’s a DNS machine on your network, you can access other machines by 
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their host/domain names—for example, DNS lets you specify www.be. com in a NetPositive browser 
window. Without DNS, you would tell NetPositive to take you to 207.126.103.9.

• Dynamic Host Configuration Protocol (DHCP). A DHCP server is a machine that can answer 
all your Internet address questions for you. DHCP makes configuring your computer easier—you 
don’t have to supply an IP address, for example—but not all computers have access to DHCP.

• Point to Point Protocol (PPP). PPP is how you get on the Internet if you’re using a modem (as 
opposed to connecting to the Ethernet). If you use PPP, you don’t need to specify an IP address for 
your computer. Instead, you have to supply the phone number, user name, and password that you 
use to connect your modem to the net. You get this information from your ISP.

• Gateway (aka “router”). A gateway is another computer, identified by IP address, through which 
your computer transmits data from your local network out to a larger network or the Internet

• Subnet mask. This is an IP address that’s used to locate your local network. In most cases, the 
subnet mask is 255.255.255.0.

Connecting to the Internet
There are two ways to connect to the Internet: By Ethernet or by modem. The first two things you do 
when preparing your computer to connect to the Internet apply to both camps:

1. Connect your network hardware—network adapter cards, modems, cables—to your computer, 
following the instructions that came with the computer or network hardware.

2. Gather IP address information from your network administrator or ISP.

Where you go next depends on which method you’re using to connect to the network:

• If you connect via Ethernet, use the Network preferences application to configure your network 
interface, as explained in “Network Preferences.”

• If you connect by modem, you use the DialUpNetworking preference, as explained in “Dial-up 
Networking: Connecting by Modem.”

Network Preferences
If you’re connecting to the Internet through the Ethernet, you use the Network preferences application 
to configure your network connection. If you’re connecting through a modem, you should go to the 
section “Dial-up Networking: Connecting by Modem.”
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When you launch Network, you see this window:

Identity
The Identity tab is where you identify your computer and manage the interfaces to your computer’s 
network cards.

Names
The Names section ask for information that identifies your computer as a node on the Internet. You 
typically get this information from your ISP or your network administrator. If you’re creating a stand­
alone network, see the section “Setting Up a Stand Alone Network” for instructions on what to fill in 
here.

Network Interfaces

The Network Interfaces section lets you Add... a new network card interface, or Modify... or Remove an 
existing one. When you add a new interface, it’s listed in the scroll view in the body of the section.
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To add a new interface, do this:

1. Click Add... to bring up the network interface 
dialog, shown here.

2. Find your network card in the Network Interface: 
popup list. If you don’t know what your card 
is, you may be able to figure it out by opening 
up your computer and looking at the card—or 
you can just guess.

3. Fill in the IP address information. If there’s a 
DHCP server on your network, click Obtain 
settings automatically (DHCP) and let the system 
get the numbers for you. Otherwise, click 
Specify settings and fill in the information 
yourself.

<=> NOTE: If DHCP can’t get all the information for you, switch to Specify settings, fill in the missing 
info, and then switch back to Obtain settings automatically (DHCP).

4. If you click the Config button you’ll see your network card’s 
Port: and IRQ: numbers and its internal address (this is not 
the same as the IP address). The defaults are port 300, 
IRQ 5, and address c8000, which work in most cases. You 
can change these, but unless you know what you’re doing 
you probably shouldn’t. Note that for some cards, the 
Address: setting doesn’t appear.

5. When you’re done playing with the interface configuration, 
click Add (back in the Network Interface dialog).
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Services
Use the Services tab of Network preferences to refine your network configuration:

Network

• FTP Server. If you want other computers to be able to download files from your BeOS system, check 
this box. Then click Login Info... and enter a name and (optionally) a password, and press Done.

• Telnet server. Check this box if you want to allow users to log in to your BeOS from a remote 
computer. If you haven’t already entered a user name and password, click Login info... and do it 
now. (The Telnet and FTP servers use the same user name and password.)

• AppleTalk. Check this if you want to print to an AppleTalk printer.

• IP Forwarding. This is often referred to as multihoming, because it requires two network cards or 
interfaces. Check this if you have one local area subnet connected to another. The other systems 
on your local network should use your IP address as their gateway (or router) address.

Saving, Restarting, and Testing the Network
When you’re done configuring the Network 
preferences, click Save. Saving tells the 
system to record your settings. When you 
Save, a dialog will ask you if you want to 
restart networking—you almost certainly do.

Restart networking?

Don't Restart I Restart

If you want to restart networking using the Network window’s current configuration, but you don’t 
want the settings recorded permanently, click Restart Networking instead of Save.
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NOTE: Restarting networking interrupts currently running network operations, such as retrieving 
mail or downloading a web page.

Your BeOS system is now configured for accessing the Internet. To test the connection, launch 
NetPositive and try to connect to a known web site (such as www. be. com). If the connection is refused 
(and you should try a few different sites just to make sure the trouble is on your end), click 
Restart Networking again. If you still have no luck, check all your settings in the Identity tab.

Backing Up and Restoring Network Configurations

Once you set up your system for networking, you can name the configuration and save it so you can 
restore it later. This is particularly convenient if you have more than one configuration and you want to 
quickly switch between settings.

To save a configuration, click the Backup button in the
Configurations portion of the Services tab. This 
window appears:

In the Backup as: field, name the configuration and
press Done to save it.

To restore a configuration highlight it in the Configurations list and click Restore. The restored 
configuration replaces the current settings. The new configuration doesn’t take effect until you restart 
networking.

Setting Up a Stand Alone Network
You may want to connect your BeOS system to other computers in a stand alone Ethernet network.
Those “other computers” can be running BeOS, Windows, MacOS, or a Unix-based operating system. 
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A set of IP addresses have been set aside specifically for stand alone networks. To configure your 
BeOS system for a stand alone network do this:

1. Bring up the Network preference, and fill in the Name fields (in the Identity tab) so the
Domain name: and Host name: fields are empty, and the two DNS: fields are 0.0.0.0, as shown here:

2. Add... a new network interface.

3. In the Network Interface dialog, find your 
network card, choose Specify settings and enter 
the following values:

— The IPaddress: is 192.168.0 . N, where TV is 
a number between 1 and 254 (inclusive).

— The Subnet mask: is 255.255.255.0.

— The Gateway: is 0.0.0.0

Unless you configure one of the computers on 
your network to act as a DNS, you won’t be able 
to reach the other computers by name. You’ll 
have to use their IP addresses instead.

Network Interface: 3Com Ether link 11/16 (ISA)

C Obtain settings automatically (DHCP) 

0* Specify settings

Config... I Cancel
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Dial-up Networking: Connecting by Modem
If you make your network connection by modem, use the DialUpNetworking preferences. When you 
launch the app, you see this window:

1. Open the Connect to: popup and choose New.

2. Type the name of the new connection in the panel 
that appears and click Done.

3. Back in the Dial-Up Networking window, type the 
phone number, user name, and password that you
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use to connect to the network, as supplied by your ISP. Check Save Password if you don’t want to 
enter your password each time you connect.

4. Click Settings to bring up the connection 
settings panel.

5. Check Use static IP address and type in your 
IP address. If you don’t check this, the IP 
address will be configured dynamically via 
PPP.

6. Enter a Primary DNS: and Secondary DNS: 
address. These addresses are not 
configured dynamically.

7. Choose a Server Type: from the popup. 
Unless you know your ISP has a Unix 
login, choose Standard PPP.

8. Click Done.

9. Back in the Dial-up Networking window, click Modem and in the panel that appears select your 
modem type, the serial port that your modem is connected to (1 or 2), and modem speed.

10. If Auto dial is enabled, whenever you attempt a net 
connection to an address not on your LAN (local 
area network), the net server automatically dials 
out for you. Even with Auto dial checked, if any 
Ethernet interface you’ve added in Network 
preferences defines a gateway, auto-dialing will 
not occur. Check Pulse Dialing if you love rotary 
phones; check Display chat when connecting if you 
want the connection panel to display the progress 
of your dial-up connection; check Log all bytes 
sent/received if you think you’ll need a binary 
dump of everything sent and received over PPP. 
This is handy if you need to debug your modem 
connection.

11. Click Done after you’ve made your selections in the modem panel.

12. When you return to the Dial-up Networking window, click Connect to start your connection.

You can have multiple connections, either to several ISPs or different accounts within an ISP. The 
configurations that you create are stored as “connection files” in /boot/home/config/settings/ppp. 
For easy access, you may want to place links to these files on the desktop. Double-clicking a 
connection file (or link) will automatically start the connection. Pointing NetPositive at a web site, 
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checking your mail, or performing any other web-accessing activity will automatically start the 
connection as well.

To delete a connection file, choose Delete from the Connect to: popup, or simply throw the file in the 
trash.

Making a dial-up connection places a dial-up icon in the 
Deskbar’s Status View that remains until you disconnect. 
Movement in the icon indicates traffic flow. You can 
press on the icon for a context menu that lets you select 
one of your saved connections and either connect or 
disconnect.

Setting Up BeOS for Both Stand Alone Network 
and Modem-Based Internet Use

You may want both a stand alone network and a modem connection to the Internet. This is common 
in small businesses or home office situations where multiple systems are connected, and only the BeOS 
system has a modem connected. You’ll want to communicate with both the local systems and outside 
network services.

To set this up, do the following:

1. Use Network to set up an Ethernet-based network interface for the stand alone network. Add a 
network interface for the appropriate Ethernet connector as if you were setting up a stand alone 
network (see “Setting Up a Stand Alone Network” on page 53).

2. Use DialUpNetworking to configure a modem connection.

3. Save and restart networking.

Once you complete this configuration, your BeOS system will be active on both network interfaces. 
You can communicate with devices on your local network through the Ethernet interface. Whenever 
you attempt to access a service that’s not on your stand alone network, the BeOS initiates a PPP 
connection. While connected to the outside network by modem, you can still communicate with any 
device on your local network.
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4 Using Network 
Services

This chapter discusses four types of network services on the BeOS:

• World Wide Web. Accessing web pages with NetPositive and setting up your own web server with 
the PoorMan application.

• File sharing. Accessing file servers and using your BeOS system as a file server.

• E-mail. Using the BeMail application and E-mail preferences.

If you haven’t already configured your BeOS system for using the Internet, see Chapter 3, “Connecting 
to the Network.”

This chapter discusses the following:

Section Page

World Wide Web Services page 59

The PoorMan Web Server page 68

E-Mail page 71

BeMail page 75

World Wide Web Services
You can browse the web with the BeOS NetPositive application, and set up a simple personal web 
server with the Poor Man application. Both applications live in the /boot/apps folder.

BeOS User's Guide Chapter 4: Using Network Services - 59



World Wide Web Services

Using NetPositive
This is the NetPositive browser window:

[j - NetPositive URL navigation buttons

File Edit Go Bookmarks
Location: |nei^^

net

View

Welcome to NetPositive

I o s v e

SSL _ 
padlock

Be Home Page
Everything you ever wanted to know about Be. (Europe- 
specific information can be found at Be Europe^ 
Welcome to the BeOS!
Details regarding your new rocket engine - the BeOS!
Be Documentation
Complete documentation for the BeOS, including the BeOS 
User's Guide, Be Book programmer's reference, etc.

fl http://www. i.com

replicant dragger status area

A

• Menus are described in “Browser Window Menus” below.

• The Location: field shows the URL of the current page; type a new URL into this field and press 
Return or Enter to go to that site.

• Navigation buttons (Back, Forward. Stop, Reload, Home) to the right of the location field let you flip 
through web pages that you’ve visited during the current NetPositive session.

• The status area shows the destination of the hyperlink the cursor is currently pointing to. It also 
shows the progress of a page download.

• The replicant dragger lets you drag the current web page as a replicant. (See “Tracker Add-ons” in 
the chapter “BeOS Basics” and “NetPositive as a Replicant—Live Desktop Pages” in this chapter.)

• The SSL (“Secure Socket Layer”) padlock appears locked if you’re in a site that is secure for sending 
credit card or personal information, and unlocked (open) if the site isn’t secure.

60 - Chapter 4: Using Network Services BeOS User's Guide

i.com


World Wide Web Services

Browser Window Menus

Not all of NetPositive’s menus and commands are described in this section—many are already familiar 
or self-explanatory. The elements described here are either of particular note or are used so frequently 
that they deserve mention. NetPositive’s preferences are described separately in “Setting NetPositive 
Preferences” below.

Go Menu

The Go menu keeps a consecutive list of pages visited in NetPositive; click any page to return to it. To 
set how long to keep pages in this list see “General Preferences” in “Setting NetPositive Preferences” 
below.

Bookmarks Menu

Use Bookmarks to add the current web page to your bookmark list. You can edit bookmarks by 
choosing Show Bookmarks. This brings up the Bookmarks window, where you can rename, organize 
into folders, and delete bookmarks.

View Menu

Document Encoding refers to the language encoding of an HTML page. If you want to read a Japanese 
(or Cyrillic, Greek, etc.) web page, you must set Document Encoding to Japanese; if you look at a 
Japanese web site with Document Encoding set to Western, you’ll see that the site is illegible. You set 
the font that’s used for a particular language in the preferences panel, as described below in “Display 
Preferences.” For languages with more than one document encoding, all encodings use the same font 
preference.

NOTE: To view Japanese web pages, or pages created for any multibyte character language, you 
need to install a font that contains the language’s characters.

Context Menus

The web page display contains two types of context menus. The context menu for any part the page 
that isn’t a hyperlink contains these commands:

Command Does this

Back Takes you back to the previous page.

Forward Takes you forward one page.

Add This Page To Bookmarks Adds the current page to the bookmark list.

Bookmarks Refers to pages added as bookmarks; selecting a bookmark takes
you to that page.
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The context menu for a hyperlink contains these commands:

Command Does this

Open This Link Opens the hyperlinked page.

New Window With This Link Opens the hyperlinked page, and puts the contents in a new win­
dow (rather than replacing the contents of the current window). 
Clicking the middle button on a 3-button mouse is a shortcut to this 
command.

Add Link To Bookmarks Adds the hyperlinked page to the bookmark list.

Save This Link As... Opens the hyperlink and saves the contents to disk (rather than dis­
play it in a window).

Copy Link Location Copies the URL of the hyperlink to the clipboard.

Setting NetPositive Preferences

Click the Edit > Preferences command to see the NetPositive preferences.

General Preferences

The General preference sets these attributes:

• Home Page:. Set to the page you want to open when you launch NetPositive.

NOTE: If you connect to the Internet by modem via PPP, consider leaving the default home page 
(netpositive: Startup.html) or else point to an HTML file on disk—or leave the home page blank.
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If you use a remote site as a home page, when you start NetPositive, the system tries to make a 
PPP connection to download that page. You might not want to do this each time you open Net- 
Positive.

• Download directory:. Set to the folder where you want your web downloads to go. If you leave this 
blank, a Save window appears each time you download a file.

• New windows:. A popup list gives you three choices for what happens when you open a new 
window: Clone current window, Open home page (the one you enter in the Home Page: text field), or 
Open blank page.

• When a new cookie is received:. Cookies are very common and very small bits of persistent data a 
server can send to be stored on your hard drive for later retrieval by that server when you return to 
that site again. An example would be the contents of your shopping cart from a site where you’ve 
selected items to buy. This preference gives you the security option of accepting the cookie, 
rejecting it if you don’t like the idea of having someone’s prints on your hard drive, or being asked 
before you do either.

• Maximum number of simultaneous connections: (per window). Lets you set the number of simultaneous 
Internet connections to make from one window. This matters if you’re using NetPositive over a 
slow link, like a modem, or running on slow hardware.

• Number of days to keep links in the Go menu:. The Go menu saves recent links. You can decide how 
long to save them, or set this field to zero to turn the Go menu off.

General settings take effect immediately.

Display Preferences

Preferences

Display preferences are fairly self-explanatory, although For the Encoding: needs some deciphering. This 
setting remembers your font preference—the Proportional Font: setting below it—on a per document 
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encoding basis. That is, you set each language encoding type (Western, Japanese, etc.) in the
For the Encoding: popup with a certain font and size. When you go to a page in Greek (and assuming 
your document encoding is set to Greek), you’ll see the page in Greek, in the font settings you make 
here.

Display settings take effect immediately.

You’d probably use Enable Proxies only if you have a proxy server for special caching, or possibly for 
security reasons if you have a firewall—if you want to run your HTTP connections through a different 
server than the one you’re actually connecting on.

To set this preference, check Enable Proxies, and fill in either a host name or IP address for HTTP: and/or 
FTP:. The FTP proxy should point to an HTTP proxy, since NetPositive only understands how to proxy 
through HTTP. You’ll need to get the Port: information from either your system administrator or your 
Internet Service Provider.

You need to restart NetPositive to make your proxy settings take effect.
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Cache

The cache is temporary storage for web pages. The default Cache Location: is /boot/home/config 
/settings/NetPositive/NetCache. You should change this only if you want to put the cache on a 
different disk.

Refresh cache: lets you choose how often (or never) to ask the server of a cached page if the page has 
been updated compared to what’s in the cache. This lets you keep cached pages as current as the 
refresh setting you choose.

You can leave Cache Size (MB): at the 10 MB default, unless you’re really squeezed for disk space and 
need to make it smaller. Set a larger cache if you’re a heavy browser and want to reduce network 
traffic.

The Clear Now button deletes all the files currently in the cache.

You need to restart NetPositive to make Cache settings take effect.
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Security

These are your security options:

• Warn when sending an unsecure form:. (Always, Never, When sending more than one line). Set this 
preference according to whether you want to be warned (or not) before sending an unsecure—that 
is, unencrypted—form, such as a credit card number.

• Warn when entering secure site: and Warn when leaving secure site:. You can ask for a message panel 
that’s displayed whenever you enter and/or leave a secure site.

NetPositive as a Replicant—Live Desktop Pages

NetPositive is replicant-enabled, which means you can put cloned web pages into other applications or 
documents, or on your desktop. The replicant has no window tab, border, or menu bar, but otherwise 
acts much like a regular NetPositive page:

• You move it by the dragger and resize it with the resize tab in the lower-right corner.

• You can go to other web sites through links or by typing into the Location: field.

• Bookmarks are available via the context menus.

• You can drag text, image, and HTML files onto the replicant.

The replicant remains active even if you quit NetPositive. If you put a NetPositive replicant on the 
desktop, the replicant will automatically “launch” and download its page when you reboot the BeOS.

For more information on replicants, see “Tracker Add-ons” in Chapter 1.
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Using NetPositive with Proxy Servers

If you connect to the network at work or school, you may have a proxy server for Internet access. A 
proxy server is a security device, filtering information that passes in and out of a network. If you’ve 
been unable to reach a web server outside your organization, it’s possible that your network 
administrator has set up a proxy server.

For information on configuring NetPositive with a proxy server see “Proxies” in “Setting NetPositive 
Preferences” above.

Accessing a Network File Server with NetPositive

To access an FTP server from NetPositive, type the file server’s URL into the URL field and press Enter. 
For example, if you type ftp: //ftp. be. com/pub/, you see the contents of Be’s public file server:

To download a file click a hyperlink. A status window shows the download’s progress. To cancel the 
download, close the status window. You can download multiple pages at the same time. Downloads 
are saved to a folder you set in the General section of your NetPositive preferences (see “General 
Preferences”). If you don’t set a download directory, a Save window appears for each download. If 
you download a compressed or archived file, NetPositive automatically launches the Expander 
application to expand or unarchive the file.
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The PoorMan Web Server
The PoorMan application lets you create your own web site. PoorMan handles HTML pages, graphics, 
and other web-based information with minimal set up and hassle. It’s ideal for small, personal servers 
and for prototyping web sites.

Setting Up PoorMan
When you launch PoorMan for the first time, you see this alert:

Poor Man was unable to locate the Web directory. 
Would you like to have a default directory created 
for you, select one, or quit?

Default Quit Select

For now, pick Default and move on. PoorMan’s main window then appears:

• Status: tells you if your server is running. Unless you turn off Controls > Run Server, the server 
should be running.

• Directory: initially shows /boot/home/PM as the default folder where your web server resides (the 
result of picking Default in the initial alert). “Selecting a Directory Folder and Index File Name” 
below tells you how to reset the directory (and why you should) and how to change the index file, 
if you wish.

• Hits: counts the number of times your web site has been accessed. You can zero this out with 
Controls > Clear Hit Counter.
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PoorMan must be running for the web server to be active. When you close the PoorMan window or 
quit the application, your web server goes down with it.

To log into your server, a user simply points his browser at your IP address or your domain name 
(given that his Domain Name Server knows how to make the conversion between the name and IP the 
address). Note that PoorMan doesn’t change the rules of the network game—it can’t provide access to 
a computer that is otherwise protected. For example, it won’t let a user breach a firewall or other 
protective coating.

Setting PoorMan Preferences
You can run PoorMan with the default configuration, but it’s preferable to configure a few additional 
settings. These sections describe the configuration options found in the PoorMan Settings dialog, 
accessed via Edit > Preferences.

Selecting a Directory Folder and Index File Name

To prevent outside access to other folders on your system, it’s a good idea to set a directory folder on 
your hard disk to use as the root directory of your web server. Place all your web pages and graphics 
in this folder.

In the PoorMan Settings window, in the Web Site Location portion of the Site tab, either type in the text 
field to change the directory setting or click Select Web Directory and choose from a file selection 
window. Your selection will appear in PoorMan’s main window

The index file is the one that comes up automatically when someone connects to your web site without 
asking for a specific document. The default index file is named index.html. To use a different file, 
type another file name in the Index File Name: text field. Don’t type in an entire path name—just supply 
the name of the file within your web directory that you want new connections to go to.
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Web Site Options

In the bottom half of the Site tab is a checkbox for Send Directory List If No Index. If there isn’t an index 
file (whatever its name) but Send Directory List... is checked, someone logging on will get a list of the files 
in your web directory. If the box isn’t checked and no index file name is given, anyone logging onto 
your server will get an error message in their web browser.

Click Done when you finish making changes in the Site tab to make your settings effective.

Logging Web Site Information

The Logging tab of the settings panel gives you two options:

• Log to Console. Check this if you want the PoorMan console (in the main window) to display a 
message whenever someone connects to your server, or downloads pages.

• File Logging. Check Log to File to send the log to a file; you name the file in the Log File Name: field. 
Alternatively, click Create Log File to bring up a file selection window where you can select an 
existing file or type in the name of a new one.

J PoorMan Settings j

In addition, the File menu in PoorMan’s main window has commands that let you write the current 
state of the log as a file.

Connection Options

A slider in the Advanced tab in the Poor Man Settings window lets you specify the number of 
connections that your server can support at the same time. The maximum number is 200; the default is 
32. How high you set this option is determined by your network capacity and your machine’s speed.

If you change the number of connections a dialog asks if you want to restart the server. Restarting 
while people are connected (that is, a file is currently being downloaded), breaks their connections.
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The Controls Menu
The Controls menu in PoorMan’s main window has four commands:

• Run Server lets you toggle your server on and off.

• Clear Hit Counter lets you zero out the Hits: field in the main window.

• Clear Console Log lets you clear out accumulated access information in the console.

• Clear Log File lets you erase the contents of your log file.

E-Mail
This section tells you how to set up your e-mail environment and describes where the BeOS stores e- 
mail messages. The BeMail application, which lets you read and write e-mail, is described in the next 
major section, “Checking for Mail.”

The E-mail Preferences Application
To set up your e-mail environment, you make a visit to the E-mail preferences app. E-mail tells the 
mail daemon—the service that actually moves mail from your computer to your mail host (and vice 
versa) how and when it should run. Launch E-mail and you see this window:

E-mail [

Account Info Mail Schedule 

POP user name:

POP password:

POP host:

SMTP host-

Check mail: Continuously *j

Every: 5 Minutes

From: 9:00* : AM-

To: 5:00 I PM"

User Settings Mail Notification

Real name:

Reply to: | linda@be.com 

Default domain: |

ICheck Now

fx
lx

|X

Show status window

Beep when new mail arrives

Autolaunch mail_daemon

Revert
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The information you enter in this window tells the BeOS where to find your mail server on the 
network, your name and password, and other mail-related options. Most of this information comes 
from your Internet Service Provider, or your network administrator.

The sections below describe each of the four parts of the E-mail preference.

Account Info

• POP user Name:. Your POP (Post Office Protocol) name is 
usually the first part of your e-mail address (for example, 
“user” in ).user@company.com

• Pop password:. If you don’t enter a password, you’re asked for 
one whenever you make a mail connection.

• POP host: and SMTP host:. These fields are the Internet domain
names or IP addresses of the servers that handle your mail.
POP is for incoming mail; SMTP (Simple Mail Transfer Protocol) for outgoing. If POP host: and SMTP 
host: are left blank, the services are disabled. If you just want to send mail, set the SMTP host and 
leave POP blank. The POP and SMTP hosts are usually the same server, but they don’t have to be.

User Settings

All of these settings are optional.

• Real name: field lets you stamp outgoing mail with your real 
name (rather than just the e-mail address).

• Reply to: is the e-mail address that you want responses to the 
mail that you send to be sent back to. In most cases, this is 
the same as your “local” e-mail address, but it doesn’t have to 
be.

• Default domain: is the domain field that’s tacked onto the end of any outgoing mail that doesn’t 
otherwise have a domain name. For example, if you set the default domain to “be.com” and then 
send a message to “fido,” the mail is sent to “fido@be.com”.

Mail Schedule

These popups let you set how often the mail daemon should 
automatically check for mail. When the daemon performs its check, 
it downloads new incoming mail from the POP host to your 
computer, and uploads outgoing messages from your computer to 
the SMTP host.
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o WARNING: If you connect to your network through Dial-up Networking, checking mail auto­
matically will start a network connection, which may require a phone call.

Mail Notification

• Check Show status window to put a Mail Status window on your 
desktop (shown below). The Mail Status window shows how 
many new and unread messages you have, lets you check for 
new incoming messages, and displays the status of mail as it’s 
sent and received. If you check Log the window expands to show 
you the details of mail access.

Mail Notification

|X Show status window

[X~ Beep when new mail arrives

[X Autolaunch mail_daemon

• Beep when new mail arrives. Check this box to set a 
system beep to announce new incoming mail.

• Autolaunch mail daemon. Check this box to start mail 
services automatically when you start the BeOS. You 
should generally always have this turned on. When 
the mail daemon is running, a mailbox icon appears in 
the Deskbar’s Status View.

All Done

When you finish configuring mail preferences, press Save. 
Press Check Now to check for new messages immediately.

You have 5 new messages (there are 
quite a few unread messages).

|X Log I Check Now

BeOS: DELE 4 
POP: +OK
BeOS: DELE 5 
POP: +OK 
BeOS: QUIT 
POP: +OK

A

¥

mail status window

Mailboxes and Checking for New Mail
The BeOS defines the /boot/home/mail directory as the repository for mail. Incoming mail messages 
are placed in /boot/home/mail/in. Messages that you send are placed in /boot/home/mail/out. If 
you create your own “mailbox” folders—into which you sort your incoming mail, for example—you’re 
encouraged to place them in /boot/home/mail alongside the folders that Be creates.

The easiest way to open one of the mailbox folders is to pop up the 
mailbox icon’s context menu (in Deskbar’s Status View).

• Open Mailbox opens the incoming mail folder 
(/boot/home/mail/in).

• Open Mail Folder opens the “parent” mail folder
(/boot/home/mail).
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The In Mailbox

When you open the incoming mailbox (as a 
Tracker window) you’ll see that the Attributes list 
has been augmented to include E-mail attributes.

The E-mail attributes include the sender’s Name, the 
Subject of the message, the e-mail address it was 
sent To (that’s you), and so on. Note that the 
Priority attribute is user-editable; you can use this 
field to prioritize your mail. Note also that the 
Name of the file is not the same as the e-mail Name. 
The file name must be unique—the e-mail name 
doesn’t have to be.

You can modify the set of attributes that the 
window displays just as in any Tracker window.

Hi in |

File Window Attributes

Mani Varad

Michael A. P 

michelle ter

Ming S. Low 
Ming S. Low |

V Name 
Size

V Modified 

Created 
Kind

Path

E-mail iw

Ming S. Low_ 101498151500:1

Ming S. Low_101598000105:1

75 items

Modified

769 bytes

868 bytes

2.48 KB

778 bytes

1.28 KB

Name 

Subject 
To 
From 

Reply To 
Status 

Priority 

When

:b
:b

JB

Thu. Oct 15 19d

Fri, Oct 16 199

Mon, Oct 19 19

Wed. Oct 14

Wed. Oct 14

Wed, Oct 14

Wed, Oct 14

HS

A
V

A

V

For more information on Tracker window attributes, see “Working with the Tracker” in Chapter 1.

The Out Mailbox

A notable feature of the out mailbox is the Status attribute. When you send mail (through BeMail) you 
get to decide if you want the message sent right away, or if it should sit in the out mailbox and wait for 
the mail daemon to perform its automated check. Messages that have been sent are marked as Sent; 
messages that are waiting to be sent are marked as Pending:

File Window Attributes

out

| Status Name Subject

cceliamf@yahoo.com >:346... Re: Fwd: no secrets —j

Sent cdance@be.com >:4330921... Re: GUI . ..ons (fwd)

Sent cbil@ccrma.Stanford.EDU>:... Re: som... Gosper? t

Pending clbj@be.com >:356340415538 •y—। j

306 items 1 1 1 r

Checking for Mail

There are a number of ways to check for new mail:

• Wait for the mail daemon to perform its automated check.

• Press Check Now in the Mail Status window or in the E-mail preferences window.

• Choose Check Now from the mailbox context menu in Deskbar’s Status View.
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Each of these methods also sends Pending mail at the same time.

BeMail
BeMail is the BeOS mail-reading and -sending application. This section describes the features of the 
BeMail application.

Creating an E-mail Message
To create a new e-mail message with BeMail, simply launch the app. A new message window will

You can also get a new message window by choosing New Message in the mailbox context menu, or by 
choosing File > New Mail Message in an existing BeMail message window.

In the message window, you fill in the recipient’s address in the To: line, the subject in the Subject: line; 
CC: and BCC: are carbon copy and blind carbon copy recipients, respectively. Notice that the To:, CC:, 
and BCC: fields are popups. When you pop up one of these fields, you see a list of People groups— 
these are group definitions that you create with the People application. This lets you send a message to 
a group of people without having to type in each individual e-mail address.

The body of the message is, of course, entered in the lower part of the window.
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Adding an Enclosure

To attach a file (or “enclosure”) to a message, drag the file into the message window; an Enclosures 
section opens with your file in it. You can also add an enclosure by choosing Enclosures > Add.

Sending

When you’re ready to send your message, choose Send Now or Send Later from the Message menu. As 
described in the “E-Mail” section, if you choose send later, the message is queued in the out mailbox 
and will be sent the next time the mail daemon checks for mail.

Reading Mail
You read incoming mail (or an old outgoing message) simply by clicking on the message. BeMail 
automatically launches and displays the message. When you’re done reading it, you can easily get to 
the next message in the mailbox through these keyboard shortcuts:

• Ait+up/down arrow closes the current message and opens the previous/next message (with no 
annoying window flashing—it all happens within the same window). These are shortcuts for 
Message > Previous Message and Message > Next Message

• Alt+T moves the current message to the trash and opens the next message (short for
Message > Move to Trash).
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Receiving an Enclosure

<Enclosure: scree
Save Enclosure...
Open Enclosure

If you receive mail with an enclosure 
attached, right-click on the enclosure line 
and a popup appears that lets you open 
the enclosure or save it. If you choose 
Save, a file selection window lets you 
direct the enclosure to the folder where 
you want to save it.

Fine-tuning BeMail
The Preferences command in the Edit menu brings up the BeMail preferences window:

• The Font: and Size: fields set the family and size of font that’s used to display the text of e-mail 
messages.

• User Level: is either Expert or Beginner. Beginners are asked more questions than experts—questions 
such as whether you really want to throw a message away when you move it to the trash.

• Text Wrapping: turns text-wrapping on and off.

• The Auto Signature popup menu lets you set the “signature” that’s automatically appended to every 
message that you send. Create a signature is described below.

• Encoding: sets the character encoding that’s used to display message text.
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Signatures

To create a new e-mail signature, choose Edit > Signatures, then type and save the signature. You can 
now select the signature from the Auto Signature popup, and it will be added to all your outgoing mail. 
The signature also appears in Add Signature in the Edit menu, so if you prefer, you can add a signature 
you create manually by choosing that command.
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5 Customizing 
the BeOS

You can customize the look and feel of your computer with BeOS preference applications. The 
applications discussed in this chapter live in the /boot/preferences directory, and can most easily be 
found by popping open the Be Menu and choosing the Preferences command.

Section Page

Backgrounds page 80

Setting the Boot Volume with the Boot Manager (Intel) or 
the Boot Preference (Mac/PPC)

page 81

DataTranslations page 82

Devices (Intel only) page 83

DriveSetup page 87

FileTypes page 92

Fonts page 97

Joysticks page 98

Keyboard page 99

Keymap page 100

Media page 101

Menu page 105

Mouse page 106

Network page 107
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Section Page

Printers page 107

Screen page 109

Screensaver page 110

ScrollBar page 111

Time (and Date) page 112

VirtualMemory page 113

Workspaces page 113

Backgrounds
Backgrounds lets you set the background color or image for the desktop and a background image for 
Tracker’s folder windows. Note that the window must be in either Icon View or Mini Icon View if you 
want to set and image:

J Backgrounds j

The popup above the right-hand section of the panel 
lets you set the background that you’re applying the 
settings to. The two Workspaces commands apply 
the settings to the current workspace, or to all 
workspaces. The two folder commands apply the 
settings to all Tracker folders (Default), or to a 
specific folder (Other). When you add a background
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Setting the Boot Volume with the Boot Manager (Intel) or the Boot Preference

to a specific folder, the name of the folder is added to the Folder: list so you can retrieve the settings 
later.

To set a background color, choose None from the Image: popup and use the color control sliders to set 
the color that you want.

To set a background image, drop the image file into the Preview box, and choose a placement option 
from the Placement: popup (the Center and Scale to Fit placements apply only to desktop backgrounds, 
not to folders). If you choose the Manual setting, the X: and Y: fields will display the coordinates of the 
image’s origin (upper-left corner). To move the image, simply drag it into the Preview screen, or type in 
the X: and Y: fields.

The Icon label background box, if checked, applies the chosen color to the boxes that contain the labels 
of icons that appear on the desktop. If it’s unchecked, the label boxes are transparent. In either case, 
the label text color is either black or white—whichever is more legible given the icon label color.

If you’re setting a background color (as opposed to a background image), the Icon label background 
checkbox is disabled and the label backgrounds are transparent. Again, the icon label color is decided 
on the basis of legibility.

Setting the Boot Volume with the Boot Manager (Intel) 
or the Boot Preference (Mac/PPC)

You can choose the BeOS volume that you boot from 
when you install the BeOS on an Intel machine, or 
using the Boot preference (shown here) after 
installation on a PPC. This is useful only if you have 
the BeOS installed on more than one volume mounted 
on your computer, or on more than one disk connected 
to it.

On Intel you set your preferred boot volume in the 
Boot Manager, which appears near the end of the 
installation procedure (see the Installation Guide that 
comes with this release for more information on the 
Boot Manager).

On PPC, the Easy/Expert popup lets you choose the 
boot volume by name (Easy) or by its “bus” address 
(Expert). If you’re booting from a SCSI hard disk, leave 
the LUN: (Logical Unit Number) set at 0.
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DataTranslations
Data translators let you open or 
save a file as a particular type. For 
example, if you want to look at a 
GIF file, you need a GIF translator 
on your system to open the file.
The DataTranslations window shows 
you which translators you have on 
your system, and, if they have 
settings (not all do), lets you adjust 
them. For example, the JPEG 
translator lets you adjust the output 
quality of the image.

The BeOS ships with TIFF, Targa, 
StyledEdit, JPEG, and BMP 
translators. Other applications 
(such as Gobe Productive) add

DataTranslations |

TIFF Images 
Targa Images 
StyledEdit Translator 
PPM Images 
■■■■■■■■ 

BMP Images

translators to your system when
you install them. To add a translator on your own, drag it into the DataTranslations window.
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Devices (Intel only)
The Devices preference lets you add, 
configure, and disable hardware 
devices. The Devices panel lists all 
hardware devices (modems, various 
cards, mouse, keyboard, etc.) on your 
computer. In addition to using the 
Devices scrolling window to see what 
devices you have, you can highlight a 
device, click Configure, and go to the 
Info tab of the panel that opens for 
basic information about the device. 
This includes whether or not it’s 
enabled, the type of device it is, 
which bus it’s on (ISA or PCI), 
whether or not a resources conflict 
exists, and so on.

The information you see in Devices is 
not always reliable—devices 
sometimes appear to be enabled 
when they’re not. If you have a 
device that shows up in the list as 
enabled, but that isn’t working, check

File Devices

Device Name Current State

v System Devices 
Motherboard Device 
RAM 
DMA 
PIC 
Timer 
RTC 
Keyboard 
Processor 
Sound 
PCI-PCI bridge 
ISA bridge

Serial Port 
Parallel Port 
Mouse

... ...... ........................................

enabled 
enabled 
enabled 
enabled 
enabled 
enabled 
enabled 
enabled 
enabled 
enabled 
enabled
enabled
enabled 
enabled 
enabled 
enabled

IRQs:

DMAs:
IO Ranges:
Memory Ranges: OxfecOOOOO - OxfecOffff, OxfeeOOOOO - OxfeeOOfff

'4

Configure...

“Troubleshooting Device Configuration Problems” below.

Configuring Devices
All devices have system resources associated with them. These resources are IRQs (interrupt requests), 
DMAs (direct memory access), I/O ports, and memory. Devices cannot generally share resources (with 
the exception of PCI devices, which can share IRQs with each other). When you boot, your system’s 
configuration manager configures all the devices in or attached to your computer so they don’t conflict 
with each other; that is, they don’t try to share each other’s resources.

Sometimes the configuration manager doesn’t manage things successfully, and one or more devices on 
your system will either turn up as disabled (you’ll know it’s disabled because it appears in red in the 
devices list) or just won’t work. There are several reasons why this typically occurs:

• There are more devices on your system than it has resources to support (i.e., there’s a resource 
conflict).

• There’s an unknown device (or devices) on the system.

• The configuration manager isn’t smart enough to figure out the device configuration.
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Identifying Resource Conflicts

Resource conflicts should occur 
only between ISA and plug and 
play devices. There are two 
perspectives from which to view 
such conflicts when they occur— 
from the point of view of the device 
or from the point of view of the 
resource:

•To identify the conflict by way of 
the device, double-click on the 
disabled device in the Devices 
scrolling list to pop open a device 
resources and info window. Then 
toggle open the Resources Conflicts 
section of the window (at the 
bottom) to see which resources are 
in conflict.

•To identify the conflict by way of 
the resource, select 
Devices>Resource Usage (Ait+U).
The Resource Usage window opens 
at the IRQ tab with the devices that 
are in conflict showing in red.

The troubleshooting section that 
follows tells you how to deal with 
some device configuration 

problems you might run into.

Troubleshooting Device Configuration Problems

Problem: Missing driver.

If a device shows up as enabled in the Devices list but is not working, the problem may be that you 
don’t have a driver for it. This is often the case with sound card failure.

Problem: Resource conflict—more devices on the system than it has resources to handle.

If something’s not working and you’ve checked that it’s connected properly, open Devices to check to 
see if it’s disabled. The usual reason a device is disabled is because of a resource conflict. If the 
disabled device is one you want to use, you’ll need to disable another device, or reconfigure the 
disabled device or the conflicting device, to free up resources for it. You can disable serial and 
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parallel port devices in the BIOS (how you do this is different for every BIOS, so check your computer 
user guide for specifics). To disable a plug and play device, highlight it in the devices list (under 
ISA/Plug and Play Devices) and double-click on it. In the resources and info panel that appears, click the 
Current Configuration button in the upper-left of the Resources tab. If the device is one that can be 
disabled, Disable Device will be active and you can click it to do the job.

It’s also possible that a device that’s not working (the mouse won’t move, the keyboard doesn’t work) 
won’t show up as disabled on the Devices list. This may also be a resource conflict. Try disabling other 
devices to free up resources and see if that fixes the problem.

Problem: Unknown device.

If you have any jumpered devices (ISA, non-plug and play cards; generally, older devices) on your 
system, it may not be able to recognize them. Do you have an old modem, sound card, or Ethernet 
card? If so, you must tell your configuration manager about it in Devices preferences. For all unknown 
devices other than internal modems, go to Devices>Add Jumpered Device>Custom and fill in the panel 
that asks you for information about the device. (You’ll need to get this information from the guide that 
came with the device.) If you don’t know all the resources a device uses, just fill in the ones you do 
know.

If the unknown device is an internal modem go to Devices>Add Jumpered Device>Modem and select a 
serial port from the popup in the configuration panel that appears. You may have to tweak the settings 
used for the modem, particularly the IRQ. If you want to do that, double-click on the new jumpered 
device and change the settings manually.

Just as with resource conflicts, if a device doesn’t show up in red in the Devices list but isn’t working, it 
may be in conflict with a jumpered device. In that case, choose Devices>Add Jumpered Device>Custom 
and create a new device in the panel that appears, then reboot.

Problem: Not-so-smart configuration manager.

If the device doesn’t appear in red in the Devices list, and probably is not a jumpered device, it may not 
be working because it incorrectly believes that it can use a certain resource (probably, but not always, 
an IRQ). To test this, force the device to use a different IRQ. There are two ways to do this:

• Create a jumpered device that uses that particular resource with Devices>Add Jumpered 
Device>Custom and reboot to make it take effect.

• Explicitly set the device’s configuration by clicking the Configure... button and entering configuration 
information in the Resources tab of the panel that appears; reboot to make your changes take effect.

You can also try to see if there’s any way to use all devices without having to disable any of them. 
Choose Devices>Resource Usage (Ait+U) to see what resources all your devices are using, then highlight 
a device, click the Configure... button to bring up its configuration information, and see if you can 
reconfigure the device to fit by hand. If this doesn’t work, you’ll have to decide which devices you need 
less and disable them while you’re working in BeOS.

BeOS User's Guide Chapter 5: Customizing the BeOS - 85



DataTranslations

Problem: There aren’t enough IRQsfor all your plug and play devices.

Try setting the Plug and Play OS to “no” in your computer’s BIOS settings—if it’s there. To find out 
how to get into your computer’s BIOS, read the user guide that came with it.

Adding Devices

In general, you should only need to add jumpered devices to your system. These are older, ISA-based 
cards that your system’s configuration manager cannot recognize. Your config manager should 
automatically configure any newer, PCI-based hardware.

To add a jumpered device:

1. Get the following information from the user guide that came with the device: IRQ, DMA, I/O 
range, and memory range. You must have all of this information before you can proceed.

2. Choose Devices>Add Jumpered Device>Custom to bring up the an “Untitled Device” panel.

If the jumpered device is an internal modem (external “plug and play” modems are automatically 
detected by the system—you don’t have to specifically add them), choose Devices>Add Jumpered 
Device>Modem. In the small configuration panel that appears, select a port for the internal 
modem from the popup, and click Add.

3. For devices other than internal modems type a name (preferably the specific name of the device) in 
the Device Name field of the “Untitled Device” window; this name appears in the panel’s yellow tab 
as you type it.

4. Select the type of jumpered device in the Device Type popup.

5. Check the IRQ and DMA setting according to the information in your device’s user guide.

6. To set IO Port Ranges, click the Add button. In the box that pops up, type in (or use the up/down 
arrow buttons) the IO port range information for your device. You can add as many devices as you 
want, but you must add each one separately, returning to Devices>Add Jumpered Device as often as 
you need to.

7. Click the Add button in the Memory Ranges section and enter the appropriate information in the box 
that pops up, then click Done to return to the new device window.

NOTE: You can add multiple IO port ranges and memory ranges to a single device, but you have 
to add them one at a time, clicking Add again to bring up the range entry box as often as you need 
to.

8. Reboot your computer. If it hangs, move on to “Troubleshooting Jumpered Devices,” below.

Troubleshooting Jumpered Devices

If your computer hangs on reboot after you’ve added a jumpered device, reboot in “safe” mode:

1. Reboot, and when the BeOS splash screen appears, press the spacebar briefly and wait for the Boot 
Loader screen to come up.
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2. Use the arrow keys to highlight Select safe mode options and press Enter, then press Enter again to 
select Safe mode. Arrow down to Return to main menu and press Enter, then choose Continue booting 
and press Enter again. The system boots in fail-safe video mode, with a grayscale screen.

Alternatively—without going into “safe” mode—you can edit the jumpered device’s settings by clicking 
the Configure... button and changing the settings in the Resources tab in the resource and info window. 
You can also delete the device by highlighting it in the Devices window scrolling list and choosing 
Devices>Delete Jumpered Device.

DriveSetup
<=> WARNING: It’s possible to lose data accidentally in DriveSetup (by initializing a drive, for 

example). Pay attention to warning dialogs to avert a catastrophe.

DriveSetup lets you work with any type of drive supported by the BeOS. You can mount, unmount, 
format, partition, eject, and initialize disks connected to your computer.

Some important terms to remember:

• A disk drive is a physical device; e.g., a SCSI or IDE hard drive.

• You can partition a disk into multiple volumes.

• A volume is a logical device. A single hard drive can have multiple volumes’, e.g., one for Windows or 
Mac OS and one for the BeOS.

DriveSetup Features
The Drive Setup window shows the drives currently attached to the system, whether mounted or not.
The window below shows three drives connected to the computer: a floppy, a hard drive, and a CD 
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drive. A small triangle appears next to partitioned drives with multiple volumes. Click the triangle to 
see all the volumes on that drive.

Q Drive Setup ; SI
Mount Unmount Setup Options Rescan

Device ] Map style Partition Type | File System [volume Name [Mounted At

/dev/disk/floppy [unknown

/dev/diak/ide/ata/0... intel Empty

BeOS Be File System BeOS R4 /boot

DOS 32-bit FAT dos windows /windows

'-D /dev/disk/ide/atapi... [no media

.....

........... 1 ..........

The table below identifies and describes the information displayed in the Drive Setup window:

Name Shows this

Device Lists the SCSI, IDE, or floppy drive devices you can mount on this computer.

Map Style Identifies the partition style. Currently the BeOS supports two styles: Apple and 
Intel.

Partition Type The specific partitions on a given volume. The BeOS recognizes BeOS, DOS 16-bit 
and 32-bit, Macintosh HFS (Hierarchical File System), ISO 9660, and “ofs” (Old Be 
File System) partitions.

File System Shows the specific file system for each volume.

Volume Name The name for each volume on a drive.

Mounted At Shows the path to the mounted volume.

Size Shows the size of each device and/or volume (doesn’t appear in the screenshot).
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Mounting and Unmounting Volumes
Mounting means displaying a drive or volume on your desktop. A volume must be mounted for you to 
be able to read it and write to it. To mount a volume:

1. Launch DriveSetup.

2. Select the device you want to mount: e.g., floppy, CD, Zip drive, etc.

3. Select the Mount menu (or pop up the context menu on the drive you want to mount). You can 
choose to mount all partitions or a specific type of volume.

Drive Setup I

Mount Unmount Setup Options Rescan
Device Map Style | Partition Type File System Volume Name Mounted At

, & fdev/disk/f loppy lunk^ 

^OCdev/disk/ide/ata/O... intel Empty

BeOS R4 /bootBe FileBeOS System

/dev/disk/ide/a

/windows

BS

To unmount a volume, follow the same steps, selecting the Unmount menu.

Partitioning a Disk
o WARNING: Partitioning a disk destroys all the data on it! Back up data you want to keep before 

partitioning the disk.

DriveSetup can create multiple partitions on a disk, except floppy disks (which are too small to 
partition) and read-only media like CD-ROMs. You partition your hard drive to allocate a portion of it 
to the BeOS. You can create either Intel- or Apple-style partitions in DriveSetup.

o NOTE: The drive or volume you want to partition must be unmounted.
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Creating Intel-Style Partitions

1. In the DriveSetup panel, choose Partition from the Setup menu. The Partition Map panel lets you 
create as many as four partitions.

2. Set the partition type in the top part of the Partition Map, using the Type popup list, or enter the 
number manually, if you know it.

3. Check the Active box of the partition you want to make active; only one partition can be active at a 
time.

4. Set the layout of your partitions in the bottom part of the window. Click the Layout button to 
choose from four preset configurations. You can also set the partition size manually by dragging 
the sliders in each partition bar. The minimum partition size for the BeOS is 200 MB.

5. The lock icons at the left end of the partition bars are there to keep you from accidentally losing 
data in partitions that you don’t wish to modify. Click the icon to unlock it. A dialog warns that 
you may lose data if you modify the partition.

You are about to edit an existing partition, if you 
modify the partition, you will lose all data on that 
partition. If the partition is an extended partition, 
you will lose ail data on all partitions within that 
extended partition.

Continue Cancel
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As further protection against losing data, the color of the partition bar changes from blue to red 
when the change you’re making to a partition’s size is about to cause you to lose data.

6. After you’ve the configured the partitions, click OK to partition the drive.

To use your new partitions, you have to mount them.

Creating Apple-Style Partitions

1. In DriveSetup, choose Partition from the Setup menu.

2. In the Partition Map panel that appears, click the Layout button to choose one of four preset 
configurations. You can alter preset configurations by clicking on a preset partition and changing 
the name, type, or size.
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o WARNING: Use only one of the preset partition types in the popup menu or your partition will 
not be recognized by the BeOS or MacOS.

3. To change the partition size move the slider left to increase or right to decrease the size. If you 
change the size, you should click update to see the new sizes of all the partitions.

4. You can also add or remove partitions with the Add and Remove buttons at the bottom of the 
window. After you configure the partitions, click OK to partition the drive. A dialog warns that you 
may lose all the data on your disk; continue only if you are sure you want to erase the disk.

Initializing a Disk
Initializing a disk prepares it for data in a certain file system format; e.g., Mac HFS, DOS, BeOS. You 
must initialize a new BeOS partition before you can write data to it:

1. In DriveSetup, select the disk or volume to initialize and unmount it.

2. Select Initialize from the Setup menu. Your initialization choices are Be File System, dos (Intel 
machines), Mac HFS, ISO 9660, or the Old Be File System.

3. A dialog that lets you name the volume and set 
the file system block size appears. The default 
size is 1024; this gives the best performance in 
most cases. If you are an expert and will have 
only a few very large files, you might want to 
increase the system block size.

Formatting a Disk
WARNING: Formatting a disk destroys all data on that disk. Back up data you want to keep 
before formatting the disk.

Formatting is a time consuming, low-level process. You should attempt it only if initialization fails.

1. In DriveSetup, select and unmount the disk you want to format.

2. Select Format from the Setup menu. In the warning dialog that appears click Format to proceed.

FileTypes
A file’s file type describes the data that the file contains. File types are used by the system—and
Tracker in particular—to figure out how to deal with a file. For example, the file type determines 
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which application opens a file when you double-click it. FileTypes lets you change the characteristics 
that pertain to a particular file type, and also lets you set the file types of specific files.

When you launch FileTypes you see this window:

File Settings

J FileTypes |

The left side of the window is a scrolling list of all the file types known to your system. File types are 
broken into broad categories (application, audio, image, and so on). The system adds new file types 
automatically when you install new applications; you can also manually add and remove types from the 
list via the dialogs accessed through the Add... and Remove buttons beneath the scrolling list.

A file type is associated with the icon that appears in the Icon box. Double-clicking in the Icon box 
(which will be empty if the type doesn’t yet have an icon) launches the Icon-O-Matic application which 
lets you create and modify icons (as explained in “Editing an Icon” in this chapter).

The File Extensions section displays the file name extensions (such as “.html”, “.gif”, and so on) that are 
associated with a file type. If a file doesn’t have a file type assigned to it already, the system will look at 
the file’s extension to try figure out what the type should be. After the type is assigned, the file’s 
extension is ignored (by the file-typing mechanism).

The file type Description is a human-readable description of a file type.

The Preferred Application is the app that’s launched when you double-click a file of the given type. See 
“The FileType Add-on” section, immediately below, for a description of ways to do this.

The Extra Attributes section lists the additional attributes that are associated with a file type. A Tracker 
window knows how to display these extra attributes when it’s in List View mode, as explained in “List
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View” in Chapter 1. Although you can add and remove attributes yourself, it’s best to leave these 
operations to applications and the system.

Opening a File

You can examine the file type of a specific file by choosing the File > Open command, or by dropping a 
file icon (or set of icons) onto the File Types window. The additional window that opens (after you 
choose the file) is identical to the window that opens when you use the FileType add-on in Tracker, as 
explained in the next section.

The FileType Add-on
Another way to access FileTypes is to use the FileType add-on in a Tracker window. The add-on is a 
convenient way to change the file type, or other characteristic, of a specific file:

1. Open a Tracker window and select one or more files.

2. Select Add-Ons > FileType from the window’s File menu or from the file’s context menu. (The context 
menu method is shown here.)

J J home

File Window Attributes

crash

Custom

Netw

Open
Open With...
Get Info
Edit Name 

Duplicate 
Move to Trash

Ctl Alt O

ALT |

alt E

1 Move to' PM L< “
Copy to

f Create Link-

Identify
Add-Ons Backgrounds

FileType !JPT Alt F

i 1̂ MakeArchive

94 - Chapter 5: Customizing the BeOS BeOS User's Guide



FileTypes

The File Type window appears:

NOTE: Changes you make in this window apply to all files that you selected in the Tracker 
window.

In the File Type section is the file type associated with the file(s). There are four ways to change the type:

• Enter (as text) the file type in the text field.

• Click Select... and choose a type from the list of all types known to the system.

• Click Same as... to make the type of this file the same as some other file (which you choose from the 
file selection panel that’s displayed).

• Drag and drop a file onto the File Type section of the panel; the file that you’re examining assumes the 
type of the dropped file.

The Preferred Application section of the dialog lets you associate a particular application with the file(s) in 
one of these ways:

• Choose an application from the popup menu.

• Click Select... to bring up a file selection panel, and choose an application by locating it in the file 
system.

• Make it the same as the application associated with another file via the Same as... button.

• Drag and drop the desired application onto the Preferred Application section of the window.

The box on the right side of the window displays the file’s icon (if it has one). To create a new icon or 
edit the existing one, double-click inside the box to launch the Icon-O-Matic application, which is 
explained in the next section.
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Editing an Icon
Double-clicking inside the Icon box in the File Types or File Type add-on window launches the Icon-O- 
Matic icon editor, where you can create and edit the icon that’s associated with a file type or with a 
specific file. Note that if the file or file type doesn’t have an icon associated with it when you double-click 
the icon box, a dialog will ask you if you want to create one; click New Icon to continue.

The window lets you create both a large icon and a mini-icon. Click on the large or mini-icon in the icon 
box on the right to switch between the icons (the red outline indicates the icon that you’re currently 
working on). To automatically generate a mini-icon from a large icon, grab the large icon (within the 
icon box) and drop it on the mini-icon.

The highlighted versions of the icons are automatically generated—you can’t create your own versions.
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Fonts
Fonts lets you set the system fonts and the size of the font caches.

There are three types of system fonts: plain, bold, and fixed-spaced. Individual fonts have additional 
popups that let you choose among style options available for that font. You can set the size, from 9 to 12 
points, with the Size: popup.

Click the Cache tab to set the size of your font caches:

• Screen font cache size: determines how much RAM is allocated to hold font bitmaps. A large cache 
mean faster screen redraws, but less RAM available for applications.
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• Printing font cache size: determines how much RAM is allocated to printer fonts. A large cache means 
faster printing, but less RAM available for applications. You need a Printer Font Cache only if you print 
to HP LaserJet-compatible printers.

Adding Fonts
The BeOS includes a TrueType font renderer, which displays TrueType fonts in almost any size. The 
standard set of TrueType fonts included with the BeOS is stored in /boot/beos/etc/fonts/ttfonts. 
These are the default system fonts; you should not change them.

You can purchase or download additional TrueType fonts in Windows (not Macintosh) format and add 
them to the BeOS:

1. Place the fonts in the /boot/home/config/fonts/ttfonts folder.

2. To tell the BeOS to look at your new fonts, click the Rescan button in the Fonts window. Or just 
reboot—the fonts are automatically rescanned when you start up the BeOS.

To add PostScript fonts, make a new psfonts folder in /boot/home/config/fonts, and put your 
fonts there. Rescan or reboot, as you would for TrueType fonts.

Joysticks
Joysticks configures the joysticks that you have plugged into your computer.

J- • Joysticks |

Game Port Connected Controller

gameport/209
Analog_2_Axee
Analog_3_Axes
Analog_4_Axes
Analog_Dual_2_Axes 
Gravis_GamePad_Pro 
Gravis_Xterminator 
Logitech_CyberMan_2 
Logitech_ThunderPad_Digital 
Logitech_WingMan_Extreme_Digital 
Microsoft_SideWinder_GamePad 
Microsoft SideWinder PrecisionPro
ThrustMaster tor^Millennium^SD,
ThrustMaster_Rage_3D_Digital

Probe f” Disabled Calibrate
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The Game Port list shows the 
available ports on your computer, 
with the port your joystick is plugged 
into selected. Probe will 
automatically attempt to figure out 
what kind of controller you have 
when you select a game port. If 
Probe can’t identify your controller, 
you can select it manually from the 
Connected Controller list.

After your joystick is identified, click 
Calibrate to display the window 
where you fine tune your joystick. 
Text at the top of the panel instructs 
you in the art of calibrating your 
joystick (the window’s appearance 
depends on the type of joystick you 
have).

Keyboard
Keyboard lets you set the delay between a 
key press and the subsequent key repeat, 
and lets you set the rate at which the key is 
repeated. New settings take effect 
immediately.

Click Revert to restore your current key­
repeat settings. Click Defaults to restore the 
settings that were in effect when you 
installed the BeOS.
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Keymap
Keymap shows you the current keymap—the characters you see on-screen when you press each key.

Q Key map

You can select a system keymap and type on the keyboard or click keys in the Key map window to see 
the resulting character in the field at the top of the window. Each keymap is made up of nine tables 
that show how the “character” keys are mapped when different modifier keys are held down (the 
default display is with no modifiers). To see a particular modifier key map, hold down a modifier key 
or combination of keys (Shift, Windows/Option, Ait) when you click or press a character key.

Different fonts map characters to different keys. You can choose a font from the Font menu to see that 
font’s mapping. This is a useful way to look for characters you don’t use often, such as bullets, accents, 
or other special characters.

You can change the keymap to support different languages or keyboard layouts. The BeOS comes 
with a number of preconfigured keymaps to choose from in the scrolling Maps list. To customize a 
keymap or create your own:

1. Choose any user or system keymap.

2. Click File and Save As... and enter the name of your new keymap.

3. Make sure the keymap is being saved to /boot/home/config/settings/keymap.

4. To make the keymap selected in the Keymap window active, click the Use button in the lower-right 
corner.

5. The new keymap is displayed in the User list.

You can customize a keymap by using the second mouse button to drag a character key from one 
position to another. When you do this, all the modifier mapping tables move with the key.

To revert to the default keymap, choose one of the standard System keymaps.
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o NOTE: Selecting a new keymap may change the shortcut key in the Menu preferences.

Media
The Media preferences panel combines Audio and Video prefs; it’s where you configure settings for 
both. You need a sound card for audio applications, and generally you need one to get sound with 
video applications, though some video cards have audio chips. You need a video capture card and 
some video output hardware or application software to use the Video preferences.

Audio
Audio replaces the old Sound preference (which has been deleted) and considerably enhances its 
capabilities. When you open Media prefs, you’ll see a list of video and audio headings on the left-hand 
side of the panel; highlighting a heading brings up its corresponding settings panel on the right.

• Highlight Audio Settings to see a panel that lets you choose your default input/output audio device. 
What you’ll see in the input/output popups reflects the type of sound card you have (if you see the 
message “This hardware has no controls,” you don’t have a sound card); unless you have more than 
one card you’ll see only one choice for input and one for output. You should check the Enable Real- 
Time Audio check box if you want to improve audio performance, but only if you have RAM to burn, 
because, as the panel explains, “It [real-time audio] achieves optimum performance by using more 
RAM.” Real-Time Audio is set to “on” by default in systems with 64 MB of RAM or more; it is set to 
“off” in systems with less than 64 MB of RAM. Checking Show Volume Control on Deskbar puts a 
Media icon in the Status Bar immediately. Once the icon is active, you can click on it to pop up a 
slider interface that lets you control system volume; when the control panel appears continue to 
hold down the mouse button and drag the slider to change volume. Right-click on the icon to pop 
up a menu that lets you open Media or Sounds preferences or the MediaPlayer directly.

Click the Restart Media Server button to make your changes take effect (except for Show Volume 
Control on Deskbar).

NOTE: If you don’t have enough RAM and CPU capacity to Enable Real-Time Audio, the box will 
be grayed out, and the text will explain the minimum requirements necessary for real time.

• Highlight Audio Input in the settings list to select your input source (CD, line in, microphone, and 
microphone + 20 decibels) and its volume (gain).

• Highlight Audio Output and either check Mute if you want no output to a certain piece of hardware, 
or leave Mute unchecked and set your output volume(s) with the sliders.

• Highlight Audio Mixer if you want to mix sound from different applications. Each time you launch 
another application, the Audio Mixer_panel expands to add another control.
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You also set the volume for your system beep, or mute it, here. You’ll see either one or two vol­
ume sliders depending on whether your input source is mono or stereo.

Old Programs applies to audio applications that were compatible with BeOS Release 3- Applica­
tions that were recompiled to run with R4, but not with the new Media Kit appear under Old Pro­
grams as one application.

The illustration below represents the Audio preference settings schematically, as input and output 
would flow with a typical sound card.

cd

• Your sound card, into which you plug your CD drive, is in the upper-left corner (“in” on the sound 
card might also appear as “line” or “line in” for connections to other inputs than the microphone 
and CD drive). The sound card is the entry point for all external sound sources, and the exit point 
(via headphones or speakers) for all sounds.

• Sound input leaving the sound card passes to input (represented by the Audio Input panel in Audio 
preferences), where you choose the sound source that will go to your application(s), and also set 
the gain level (volume) of that sound (to the application—this gain setting has nothing to do with 
output). Many sound cards take “0” to mean “normal input level,” and any larger number to mean 
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“additional boost for the input signal”; consequently, a “0” level setting might not necessarily result 
in silence.

Sound from the sound card also passes directly to output (represented by the Audio Output panel 
in Audio prefs), where you decide which input sources—CD, Line in (on some cards labelled 
“AUX”), BeOS, and Microphone—will be heard as output (by muting them or not), and at what 
level (volume). This is what you will hear from your speakers or headphones.

• Sound input flows via sound-generating applications to the mixer (represented by the Audio Mixer 
panel in Audio prefs), which is where you set the relationships between different sounds in an 
application (or multiple applications) by setting their gain levels and by muting them or not.

• Mixed sound goes to output, where you decide (or you’ve already decided) on muting and sound 
levels you want to hear in your headphones or speakers.

Video
The Video preference is new in this release. You need to configure this preference if you have a video 
capture card, to which you’re connecting a video camera, a VCR, or your cable TV line, in order to 
view, record, or save data from one of those sources. This release has support for video capture cards 
based on the Bt848, Bt878, and Bt879 chips. For a regularly updated list of video cards that use these 
chips, see <http://www.be.com/products/beosreadylist.html>.

• In the Media preferences, highlight Video Settings (in the list on the left-hand side of the panel). 
This is where you choose your default input/output video device. What you see in the input/output 
popups reflects the type of video capture card and video output hardware and software you have; 
unless you have more than one of each you’41 see only one choice for input and one for output.
You should check the Enable Real-Time Video check box if you want to improve video performance, 
but only if you plenty of RAM, because real time requires lots of RAM (as explained in the panel).
Enable Real-Time Video is set to “off” by default. After you make your selections in this panel click the 
Restart Media Server button to make your selections take effect.

• Next, highlight Video Input to choose the configuration options for your video capture card. Again, 
the controls you’ll see depend on the type of card you have. The information here is based on 
settings for Bt848 cards.

In the Controls tab, choose your video source from the Video Input popup. Some possible options 
are Composite 1 and 2 (RCA standard jacks), Tuner (TV or cable), and SVideo jack, but the four 
choices you actually have reflect the names you set in the Input Names tab (see below). Choose a 
setting from the Channel popup if your video source is a tuner or cable TV. Choose your audio 
source, or mute, from the Audio Input popup. (It’s often necessary to connect your video card to 
your sound card to get audio; see the installation instructions that came with your video card for 
more information.) You can adjust the Brightness, Contrast, Saturation, and Hue sliders by referring 
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to the image in your video window (you must be running your video application software to see 
a video window).

The Video Input Options tab is where you set Default Image Size and Default Colors. Your application 
should specify what these are. The additional four checkbox settings in this tab are filters. To 
summarize them briefly, Luma Coring (luminance) reduces anti-aliasing artifacts; Chroma Comb 
(chrominance) enhances color consistency; Gamma automatically corrects screen brightness; and 
Error Diffusion tries to remove visual anomalies and static. These settings are checked “on” by 
default.

The Input Names tab lets you identify video and audio inputs 1-4 with the actual inputs you’ve 
connected them to; for example, if your Video 1 input is connected to Tuner, you can make that 
connection explicit in the Input Names tab.

You configure the Hardware Setup tab according to your terrestrial location and the hardware 
you’re using. The Video Format for the U.S., for example, is NTSC-M. The manufacturer of your 
video capture card can use any one of several Tuner brands; the most common is Phillips, but 
check your card to be sure. Set Tuner Locale according to the method of broadcast transmission in 
your local area. Audio Mux Type (“mux” is short for “multiplexor”) applies to a video card that has 
multiple inputs but selects one output; 99% of cards are type “0” (the default), but if you don’t get 
sound output from that setting, try “2” and, if you still get no sound, try “10.” Audio Format (visi­
ble only if your card supports it), like Video Format, is location specific.
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Menu
Menu lets you change the appearance and behavior of menus throughout the BeOS. Most importantly, 
it lets you set the system-wide shortcut key—this is the key that you use in combination with a 
character to “silently” perform a menu command.

Menu |

Font >
Font Size >

Click to Open
x/ Always Show Triggers

Color Scheme...
Separator Style >

ctl as Shortcut Key

1/ alt as Shortcut Key

The settings in the Font preference are.

Setting Lets you do this

Font Choose a font and style.

Font Size Choose a font size.

Click to Open If checked, lets you open a menu or submenu by clicking the menu’s title; if 
unchecked you can only drag through menus.

Always Show Triggers If checked, triggers for menu titles, commands, and other menu items are 
always visible and can be activated by pressing the trigger letter.

Color Scheme Set the colors that are used in menus.

Separator Style Choose the type of separator that’s used to group commands in a menu.

Key as Shortcut Key Choose Alt or Control (“Ctl”) as your shortcut key. (On Macintosh, the Alt 
key appears as the Apple “cloverleaf.”)

Menu changes are enforced when you launch an application. For example, if you change the menu 
font size, the applications that are currently running aren’t affected, but all subsequently launched 
applications will display the change.
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Mouse
Mouse lets you tell the system how many buttons are on your mouse, and lets you set the mouse’s 
double-click speed, the speed with which it moves the cursor, and whether window focus should 
follow the mouse:

• Set double-click speed with the Double-click speed slider; test your setting in the Click test area.

• Use the Mouse Speed slider to set how fast the cursor moves across the screen when you move the 
mouse.

• You can set the number of buttons on the mouse you use with the Mouse type popup, and rearrange 
the default order of the mouse buttons with the individual button popups.

• The Focus Follows Mouse setting affects the cursor and it’s relationship to windows on the desktop. 
The Focus Follows Mouse popup gives you four choices:

— Disabled (the default) means the frontmost window is live; clicking in another window brings 
it to the front and makes it the live window.

— Enabled means the window the cursor is over is live; with Enabled checked, you click once in 
a window’s tab or the thin outer window frame to toggle between applications.

— Warping causes the cursor to move to an application you’re toggling to (the target app).

— Instant warping is the same as Warping, but faster; you don’t see the cursor move to the target 
app.

o NOTE: A single-button mouse can emulate a three-button mouse: Press Ctrl+Alt while clicking the 
mouse button to emulate the second mouse button, and Ctri+Win while clicking to emulate the 
third mouse button.
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Network
The Network preferences is explained in Chapter 3, “Connecting to the Network.”

Printers
The Printers preference lets you add, remove, and select a default printer in the top part of the Printers 
panel (Printers) and check the status of your print job and other jobs pending on your machine for that 
printer in the bottom part (Print Jobs for [name of selected or default printer]).
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To add a printer click Add..., then 
choose whether you want to add a 
local or network printer in the panel 
that appears and click Continue. You 
can print to an Appletalk network 
printer without running World o’ 
Networking (explained below); to 
print to any other type of network 
printer you must be running World o’ 
Networking.

If you choose Local Printer and click 
Continue, a window opens that asks 
for a printer name, type (there’s a Preview option in the Printer Type popup, covered momentarily), and 
connection method (there’s also a Print to file option, which we’ll get to in a minute); with network 
you’re asked for a printer name and type. Supply the required information and click Add to add your 
printer to the Printers portion of the preference panel; click Make Default if you want this as your default 
printer.

If you want to print to a non-Appletalk network printer, you must be running World O’ Networking 
(aka WON, the network sharing interface included in the R4.5 /optional/experimental directory). 
With WON running, when you choose to add a network printer you’ll be asked in the Add a Network 
Printer dialog for a Network printer path. If you know the path to the printer, you can type it in.
Otherwise, click the Browse... button to open a selection window that shows what’s on the network and 
choose your printer there to set the path.

To remove a printer, highlight it and click Remove. Note that in the Tracker, when you click on a 
network printer that’s already configured, the Printers pref opens with that printer selected, so you can 
see pending jobs, make it the default printer, remove it.

You’d probably use Print to file, in combination with an Apple Laserwriter-compatible printer, to send 
PostScript output to a file. Print to file in combination with other printer types produces output to a file 
in the page description language of the specified printer.

Print Preview—a virtual, onscreen printer that lets you view print output onscreen, and make decisions 
about font, layout, and so on, without wasting paper—was added in Release 4. You access it in R4.5 
by choosing Add in the Printers panel; this brings up the Add a Local or Network Printer dialog, where you 
choose Local Printer and then click Continue. The Add a Local Printer dialog opens; choose Preview from 
the Printer Type popup, and you’ll be able to review onscreen what your print output will look like on 
paper.

108 - Chapter 5: Customizing the BeOS BeOS User's Guide



Screen

Screen
Screen lets you set your monitor’s screen resolution, bits per pixel, and refresh rate.

The Current Workspace/AII Workspaces popup lets you choose the scope of the settings that you’re 
about to apply. After you click Apply a dialog appears that asks you to confirm your choice. If you 
don’t confirm within some amount of time (about seven seconds), the screen reverts to its former 
settings. Note that you can adjust the refresh rate in .1 Hz increments by pressing the Left/Right arrow 
keys on the keyboard—this technique is useful when you’re fine-tuning for the best-looking refresh 
rate. When adjusting the refresh rate in this manner, the confirmation dialog doesn’t appear.

Initially, the BeOS displays a 640x480, 8-bit, 60.1 Hz screen. If your graphics card and monitor can 
accommodate a higher resolution, more colors per pixel, or a faster refresh rate, you should change 
these settings (see the WARNING below).

For detailed information about what kinds of graphics cards work with the BeOS, see the Be web site 
(http://www.be.com/products/beosreadylist.html).

TIP: To solve most screen problems press Alt+Contr6I+Shift+FT2 to restore all default settings 
except desktop color (this shortcut works at any time, even when Screen isn’t running, though 
the default settings aren’t saved unless Screen is running).

WARNING: You can do serious damage to a monitor if you select a resolution, number of colors 
per pixel, or refresh rate the monitor isn’t designed to support. Read the manuals that came with 
your monitor and graphics card to find out what combinations of settings are safe for the 
monitor. An alert dialog that appears before your changes take effect gives you a chance to 
cancel a setting you’re unsure of before implementing it.
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Adjusting the Screen Size and Position
When the Screen window is active, you can adjust the size of the screen image on the monitor by 
holding down the Shift key while pressing the arrow keys. The Up/Down arrow keys resize the screen 
vertically, and the Left/Right arrow keys resize it horizontally. You can adjust the position of the screen 
image by holding down the Control key and pressing the arrow keys.

Screensaver
Open Screensaver preferences 
and check Enable Screensaver at 
the top left of the panel’s Fade 
tab. Set the Run module slider 
for the length of time you want 
the screen to remain idle 
before the module starts.
Check Turn off screen and set the 
slider if you want your screen 
turned off after some amount 
of idle time. Check Password 
lock and the time for it to take 
effect if you want password 
protection on your monitor.

You can also use the monitor 
icons at the bottom of the Fade 
tab to set when you want to 
fade to the screensaver or not, 
depending on the location of 
your mouse.

ScreenSaver |

Fade Modules

“[X Enable Screensaver

Run module

F Turn off screen

P” Password lock

Fade now when 
mouse is here

2 minutes

8 minutes

2 minutes

Don't fade when 
mouse is here

[password"? j
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Now go to the Modules tab and choose a screensaver from the list (click Test to try it out).

J Screensaver |

Fade | Modules

~ Module settings

Bouncing Lens

You can add a screensaver in /boot/home/config/add-ons/screensaver.

ScrollBar
ScrollBar lets you set the look and feel 
of your window’s scroll bars:

Choose the Arrow Style, Knob Style, and 
Knob Type you prefer. Drag the green 
arrow to adjust the minimum scroll 
knob size. Click Defaults to return all 
the settings to the way they were when 
you first installed the BeOS. The 
settings you make in the Scroll Bar 
window affect windows when you next 
open them.
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Time (and Date)
Tim© & Date | 

Settings ] Time Zone |

f October 7 ST? 1998 $ [ 0477? : 48 AM~

S M T W T F S
1 2 3

4 5 6 7 8 9 10

11 12 13 14 15 16 17

18 19 20 21 22 23 24
25 26 27 28 ® 30 31 A , ±.

Clock set to: V Local time
r GMT

You set the date and time with Time:

In the Settings tab you can set the date by 
highlighting each element in the date bar and 
clicking the up or down arrows; to set the day of 
the month only, click in the calendar. You can 
set the time by highlighting elements in the time 
bar and clicking up or down, but it’s more 
entertaining to drag the clock hands around.

If you are running the BeOS on a computer on 
which you also plan to run Windows, leave the 
setting on Local Time. The reason for this is 
that Windows sets the computer’s internal clock to the local time in your time zone. If you change the 
BeOS preference to GMT, adjust the time, and then run Windows on your computer, the Windows 
desktop clock will be incorrect. If you then reset the time in Windows so the desktop clock shows the 
correct time, the time when you next run the BeOS will be incorrect.

o NOTE: The BeOS handles Daylight Savings Time automatically, so you don’t need to remember 
to fall back or spring ahead.

The default Time Zone setting is for Menlo Park, California. If you’re in a different time zone, change this 
setting and click Set. This sets the correct time for your zone in the Settings tab.

Time & Date

Settings | Time Zone ;

North and Central America

Jamaica 
Juneau
Knox, Indiana 
Los Angeles 
Louisville 
Managua 
Marengo. Indiana 
Martinique 
Mazatlan
Menlo Park. Calif

Current time zone:
Menlo Park. Calif 04:47 AM

Time in:
Menlo Park. Calif 04:47 AM

A 
V Set
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VirtualMemory
VirtualMemory lets you set the amount of disk space 
that’s used to augment the physical RAM on your 
system:

The VirtualMemory window displays the amount of 
installed RAM (Physical Memory:) and the amount of 
hard drive space allocated to virtual memory (Current 
Swap File Size:). You can’t change the physical memory 
(at least not from software), but you can change the 
virtual memory size—simply drag the slider around (or 
Tab to highlight the slider and use the arrow keys to 
adjust it in 1 MB increments). You have to reboot to 
make your change take effect.

VirtualMemory

Physical memory: 32 MB

Current swap file size: 80 MB
Requested swap file size: 181 MB

80 MB 565 MB
A Changes will take effect on restart

Default Revert

The amount of virtual memory that you can request is based on the amount of free space on your boot 
disk. VirtualMemory may restrict the size of the swap file that you request.

Workspaces
Workspaces is an interface to the different working areas, or workspaces, that you have set up. The 
default number of workspaces is nine but you can have as many as 32; you set this number in Screen 
preferences. Each workspace can hold its own set of windows that you’re working in. You use 
different workspaces to organize your work—productivity apps in one workspace, audio/visual in 
another, mail in a third, and so on.

When you launch Workspaces, a “workspace map” is displayed; the windows in each workspace are 
represented in miniature:

workspace 1
workspace 2

workspace 3

workspace 4
workspace 5

workspace 6

workspace 7
workspace 8

workspace 9
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To switch to another workspace, click in a “pane” in the Workspaces window, or press Ait+Fn (function 
key ri) where n is a number between 1 and 9: SB+EL takes you to the first workspace, Ait+F2 takes you 
to the second, and so on. As displayed in the Workspaces window, workspaces are numbered left-to- 
right and top-to-bottom, as shown above.

You can move a window from one workspace to another by dragging its miniature representation in 
the Workspaces window. When you open a folder that’s already open in another workspace, the 
window is brought into your current workspace, and is removed from the workspace it was in. 
However, if you select a window from the Deskbar’s Window List, you’re taken to the workspace that 
the window is open in (“remote” windows are indicated by “speedlines” in the Window List).
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Appendix A: 
The Mouse 
and Keyboard

Using the Mouse
The BeOS recognizes one-, two-, and three-button mice. By default, 
the left button is the first button; the right button is the second; and 
the middle button is the third.

To reset the button order, use the Mouse preferences (see “Mouse” 
in Chapter 5, “Customizing the BeOS”).

Simulating a Multiple-button Mouse
A single-button mouse can simulate a two- or three-button mouse.
On a PC keyboard (including a Windows keyboard), the key combinations, based on the 104-key 
Windows keyboard, are these:

• Control+Alt+click simulates the second mouse button.

• Control+Win+click simulates the third mouse button.

Use the Mouse preferences to adjust the timing of multiple clicks and set the cursor’s movement speed. 
These are the basic mousing terms used in this guide:

This Means To Do This

Move Move the mouse without pressing a mouse button.

Click Press and quickly release a mouse button without moving the mouse.

BeOS User's Guide Appendix A: The Mouse and Keyboard - 115



Which Key, Which Keyboard?

Press Press and hold down a mouse button without moving the mouse.

Drag Press and hold down a mouse button while moving the mouse.

Double-click Press and release a mouse button twice in quick succession.

Double-click 
and drag

Like a double-click, but hold down a mouse button instead of releasing it 
the second time, then move the mouse.

Which Key, Which Keyboard?
This table shows the equivalent keys for different keyboards.

Windows keyboard (104 
keys)

PC keyboard (101 keys) PPC (Mac) keyboard (105 
keys)

St St Command

Left/Right Windows key Right Alt Option

Left /Right control Left/Right control Left/Right control

Backspace Backspace Delete

Menu key (no equivalent) (no equivalent)

(above arrow keys) Delete (above arrow keys) Del (above arrow keys)

Enter (main keyboard) Enter (main keyboard) Return

Enter (numeric keypad) Enter (numeric keypad) Enter (numeric keypad)

Choosing a Shortcut Key
Menu preferences lets you choose a shortcut key—that is, the key you use to invoke a shortcut. What’s 
available to choose from depends on your keyboard.

Shortcut key Windows keyboard 
(104 keys)

PC keyboard (101 keys) (Mac) keyboard (105 
keys)

St AiF means both the right 
and left 
shortcut key.

St as the shortcut key 
applies to left Ait only; right
Alt is the Option key.

N/A
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Keyboard Shortcuts

Shortcut key Windows keyboard 
(104 keys)

Control Control means both the
right and left Control keys 
work as the shortcut key.

Command key N/A

PC keyboard (101 keys)

Control means both the 
right and left Control keys 
work as the shortcut key.

N/A

(Mac) keyboard (105 
keys)

Control means both the left 
and right Control keys work 
as the shortcut key.

Command or Control means 
both the left and right Com­
mand and Control keys 
work as the shortcut key.

For simplicity, a 104-key keyboard with Alt as the shortcut key is used throughout the user guide.

Keyboard Shortcuts

System Shortcuts

NOTE: The addition of the Shift key to some combinations will perform the action in reverse.

Action or key 
combination

Means

Alt+Escape Activate/deactivate (but not open/close) the first menu in a window.

Escape Cancel (available, but not all applications use it).

Tab Change keyboard focus to the next item in a window or panel.

Ait+Tab Change keyboard focus to next group of controls (e.g., in a preferences panel); 
does this by highlighting first control in the group.

Control+Tab Bring up the Twitcher app, which lets you switch apps with the keyboard. If 
you make Control your shortcut key, use Ait+Tab to bring up the Twitcher.

Win+Tab Force a jump to the next control, if inputting text.

Return Press a default button.

Spacebar Activate or toggle the current control (button, checkbox, etc).
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Tracker Shortcuts
Several Tracker shortcuts include both keyboard and mouse action.

MeansAction or key combination

Click an item.

Click and drag across one or more items.

Type one or more letters.

arrow

Shift+ mouse click or drag. If you drag with 
the mouse, release the button before releas­
ing the Shift key.

Sh\h+letter

Alt+O or Return/Enter

AR+D

Win+double-click

Win+drag

Aft+Up Arrow

Alt+Down Arrow

Alt+Win+Up arrow

Alt+Win+Down arrow

Afi+F

AH+Y

Select the item.

Select the items you drag across.

Select the item that starts with that letter or letters.

Select the next item in the direction of the arrow. You 
can also select Tracker window items using Tab and 
Shift+Tab, as described in “System Shortcuts.”

Select or deselect additional items.

Select or deselect additional items.

Open the selected item.

Duplicate the selection.

Close current directory before performing an action.

Copy a selection to a new location rather than move it.

Close the current folder and open its parent.

Open any highlighted folder.

Close the current folder and open its parent.

Close the current folder and open the selected folder.

Open Find dialog-—initiate a query.

Resize to fit.
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Application Shortcuts
This is a summary of the most common application shortcuts:

Action or key combination Means

A]t+N Open new application window.

fflt+O Open a file or folder.

Afi+S Save current work in a file.

fflt+ShB+s Save a file by a different name.

Ht+z Undo work since last save.

Alt+Shft+Z Redo last undo.

AR+W Close application window.

Alt+Shft+P Open Page Setup preferences for printing.

aB+p Print.

Afi+Q Quit the application; same as Close if only one application 
window is open.

AB+W Close the current window; quit the app if only one application 
window is open.

Menu Navigation and Selection Shortcuts
The table summarizes keyboard and mouse shortcuts for navigating menus and selecting items:

To Do this

Open a menu • Click the menu title and release the mouse, or
• click the menu title and hold the mouse button, or
• press Alt+Escape and type the menu title’s trigger letter or use arrows.
• or, press the Menu key on a Windows keyboard.

Navigate a menu • Drag the mouse through menu items, or
• press the Up /Down arrow in an open menu.

Choose a menu item • Click the item with the mouse, or
• type the item’s trigger letter (if it has one), or
• select an item by dragging with the mouse or using the arrow keys, then 

press Enter/spacebar.
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To Do this

Close a menu • Choose an item, or
• click elsewhere in the window, or
• press the Escape key.

File and Document Management Shortcuts

Key combination Means

AR+O Open the selected file or document.

Ht+N Open a new file or document.

St+s Save the current file or doc; same as “Save As” for a file not previ­
ously saved.

Ait+Shift+S Save As, or save the current file/doc in a new file.

AK+P Print.

Ait+Shift+P Open the Page Setup dialog.

Text Selection and Editing Shortcuts
These apply to word processors, text editors, and terminal emulators..

Keyboard/Mouse combina- Means 
tion

Click Select an insertion point.

Double-click Select a word.

Triple-click Select a paragraph.

Drag across text Select a character at a time.

Double-click and drag Select whole words at a time.

Triple-click and drag Select whole paragraphs at a time.

Shift Extend or reduce a range of selected text.
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Keyboard Shortcuts

Keyboard/Mouse combina­
tion

Means

Control+Shift+arrow Select one space to the left or right of the cursor (with left/right 
arrow keys) or a line above or below the cursor (up/down arrow 
keys).

Ah+A Select all.

fflt+Z Undo; redo if multiple undo not available.

The following text-editing shortcuts are based on the Clipboard feature. Affected text can be moved 
between windows in one application or between windows in different applications.

Key combination Means

at+x, Cut the selected text.

AE+c Copy the selected text.

aR+v Paste the selected text to the right of the cursor.

Document Navigation Shortcuts
These shortcuts apply generally to word processors, text editors, and terminal emulators, though some 
apply only to text documents.

Action or key combination Means

Left arrow Move the cursor left.

Right arrow Move the cursor right.

Up arrow Move the cursor up.

Down arrow Move the cursor down.

Control+Left arrow Move the cursor back one word.

Control+Right arrow Move the cursor forward one word.

Control+Up/Down arrow Skip by paragraphs.

Home Move the cursor to the beginning of the line.

End Move the cursor to the end of the line.
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Action or key combination Means

Page up/down Move the cursor up/down one page (screen).

Control+Home Move the cursor to the beginning of the doc.

Control+End Move the cursor to the end of the doc.

Control+Page Up/Down Move the cursor to the top or bottom of current page without 
moving the page.

Document Viewing Shortcuts
These shortcuts apply to read-only documents, such as HTML, Adobe PDF files, manpages, etc.

Key combination Means

Left/Right arrow Scroll left/right.

Up/Down arrow Scroll up/down.

Alt+Left/Right arrow Go to the previous/next document (in a browser).

List View Shortcuts
These shortcuts apply to List Views in Tracker windows, mail/news readers, music playlists, and so on.

Action or key combination Means

Up arrow Select the previous item to currently selected one; select first item 
in the list if no there is no highlighted selection.

Down arrow Select the next item from the currently selected one; select the last 
item in the list if there is no highlighted selection.

Alt+Right arrow Expand a folder, thread, menu, etc.

Alt+Left arrow Collapse a folder, thread, menu, etc.

Return or space bar Activate the selected item(s).

AB+A Select all.

Letter keys Move to the closest alphabetic match.
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Keyboard Shortcuts

Action or key combination Means

Tab Move to the next item in order.

Shift+Tab Move to the previous item.

Shift+click Select contiguous items as the mouse is dragged.

Miscellaneous Shortcuts

Key combination Means

Control+Tab Holding down Control while pressing quickly on Tab cycles through the 
open applications without bringing up the Twitcher application 
switcher interface.

Alt+F1-F12 Pressing Ajt+a numbered function key switches to that number desktop 
in the Workspaces application.
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Appendix B: 
Miscellaneous

Taking a Screen Shot
There are two ways to take a screen shot in the BeOS: Press the Print Screen key or Alt+Shift+3. The 
screen shot appears in the /boot/home folder on your boot disk. All screen shots are in targa format. 
You can open the screen shot by double-clicking the file or by dragging it onto the Showimage 
application.

Adding Drivers
Third-party software drivers should install themselves correctly without your help. For informational 
purposes only, drivers always live in the /boot/beos/system/add-ons/kernel/drivers/bin 
folder. The actual driver binary goes into . . . /drivers/bin. The driver’s installation process creates 
a symlink that points back to . . . /drivers/bin. The symlink directory hierarchy parallels the actual 
hierarchy a driver creates when it names its devices. The purpose of this is to cut kernel overhead 
when it scans for drivers; it only needs to search in . . . /add-ons/kernel/drivers, instead of 
scanning through all the drivers in /bin.

For example, if you install a Parallel Slingshot driver (a fictional driver), the Parallel Slingshot binary 
goes into . . . /drivers/bin; its symlink goes into . . ./drivers/dev/parallel slingshot.
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Appendix C: 
The BeBox Guide

Be, Inc., will continue to support BeBox hardware until January 1, 2000. This appendix contains 
information about installing the BeOS on a BeBox, along with general pertinent usage information.

You install BeOS Release 3 the same way you’ve installed previous releases. Before you install, 
however, follow these steps to upgrade the boot ROM:

1. Boot from the Release 4.0 CD.

2. In the /beos/etc folder, you’ll see the ROMUpdater application and a file named 
bebox_bootmain. image.

3. Press the Control key and drag the bebox_bootmain. image icon onto the ROMUpdater icon.

4. A dialog tells you when the boot ROM has been upgraded.

5. Reboot and proceed with the installation.

<=> NOTE: While it’s no longer absolutely necessary to update the boot ROM, bug fixes in Release 4 
will make booting a more pleasant experience if you do update.

Using Floppy Disks with the BeBox
You can reliably read/write to floppy disks on the BeBox. These types of floppies will work:

• Standard MS-DOS formatted 720K and 1.4MB disks

• Macintosh HD 1.4MB disks (but not Macintosh 800K disks)

• BFS formatted 720K and 1.4MB disks
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Using Floppy Disks with the BeBox

Initialization
You can initialize MS-DOS and BFS floppies using the DriveSetup application. In the Setup menu, 
choose Initialize and then either Be File System or dos.... Note, however, that you cannot initialize Mac 
HFS floppies on the BeBox; those you wish to mount must already be initialized.

Mounting a Floppy
To access your DOS, BFS, or Mac HFS floppy, insert it in the floppy drive and mount it. You can do this 
using either DriveSetup’s Mount command or the Mount command in the desktop context menu, or the 
context menu that appears when you right click on the icon of a mounted volume.

Using Drive Setup

1. Highlight the /dev/disk/floppy line in the DriveSetup window.

2. Choose Mount from the Mount menu to mount the initialized disk.

3. A floppy icon will appear on the desktop.

Using a Context Menu

1. Right-click on an open area of the desktop or on the icon of a mounted volume.

2. Choose Mount from the context menu that appears, and then choose the floppy.

3. A floppy icon will appear on the desktop.
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Appendix D: 
Working with the 
Mac OS Tools

The BeOS CD includes two Macintosh programs: TTConverter, which converts TrueType fonts for use 
on the BeOS, and Netfinder, which lets you transfer files over the network from the BeOS to the Mac. 
The following sections examine these tools.

Converting TrueType Fonts
Converting Macintosh TrueType fonts for use on the BeOS is a two-step process:

• Use the TTConverter that comes with your BeOS in the Macintosh Utilities folder to convert fonts to 
BeOS format.

• Install converted fonts in the BeOS

When you install the BeOS, a folder called Macintosh Utilities is created on the Macintosh volume. 
This folder contains TTConverter, which converts Macintosh TrueType fonts into a format that the 
BeOS can use. Most TrueType fonts can be converted using this utility with the exception of Apple’s 
standard fonts that ship with the Mac OS (Chicago, Courier, Geneva, Helvetica, Monaco, New York, 
Palatino, Symbol, and Times).

<^> NOTE: The BeOS uses the same TrueType format as Microsoft Windows. If you acquire new 
Macintosh fonts, get them in TrueType format, or convert them with the TTConverter.
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Launching the TTConverter and Converting Fonts
Look for the TTConverter in the BeOS Mac Tools/Mac Utilities folder, then follow these steps to 
convert TrueType fonts for use with the BeOS:

1. Double-click on the TTConverter icon and select Convert from the File menu.

2. A dialog let you choose the font you wish to convert (e.g., Arial).

3. You can convert all of the font types associated with a font. An additional dialog lets you save them 
all or skip the font styles you don’t need. Converted files have a filename that ends in .TTF (e.g., 
ARIAL.TTF, ARIALB.TTF, ARIALI.TTF, ARIALBI.TTF).

Installing Converted Fonts in the BeOS
After you convert the fonts, copy them over to your BeOS volume. Mount your Macintosh volume and 
copy the .TTF file into /boot/home/config/fonts/ttfonts. Once they are there, restart the BeOS to 
activate the new fonts, or use the Fonts preferences application to rescan the installed fonts.
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Transferring Files with Netfinder

Transferring Files with Netfinder
The BeOS installation CD includes a Mac OS tool called Netfinder, which lets you transfer files over the 
network from the BeOS to a Macintosh. Netfinder is shareware. The documentation that accompanies 
Netfinder contains detailed technical information as well as the shareware license.

File transfer involves three steps:

• Setting up your network.

• Turning on Internet file sharing.

• Transferring files with Netfinder.

Setting Up Your Network
When setting up the Mac OS for Internet file sharing using the TCP/IP control panel, you should refer 
to your Mac OS documentation for help. You can also refer to the chapter “Connecting to the 
Network.” You’ll find the concepts, steps, and basic definitions are very similar. If you’re not 
connected to the Internet but still want to set up a connection using the Internet protocols, read 
“Setting Up BeOS for Both Stand Alone Network and Modem-Based Internet Use” in the same chapter.

Turning on File Sharing
Your BeOS system includes a built-in FTP server for serving files to hosts on a TCP/IP network. To 
allow other computers to see and copy the files on the BeOS, you have to turn on the FTP server:

1. Launch the Network preferences application.

2. Go to the Settings tab.

3. Check the Enable FTP server check box.

4. Assign a user name and password.

5. Save your changes and click the Restart Networking button.

You are now ready to transfer files.

Using Netfinder for Mac OS to Transfer Files
Netfinder for Mac OS is included on the BeOS CD. To run this application, double-click its icon. Type 
in the IP address of the BeOS machine to which you wish to connect in the Host: field. Enter the user 
name and password in the appropriate areas. Also be sure to put the “/” in the Path: field, which opens 
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your connection at the root of the volume, making navigation of the remote file system much easier. 
Click the Connect button to activate your connection.

Enter details (leave Username blankfor anonymous login):

====== New HP Connection ====

| Get Info-Mac Mirror | | Get U-Mich Mirror ]

( Get Default ] [ Load Bookmark... | | Cancel | 

| Make Default ] [ Save As Bookmark... ] | Connect];

Once connected, you’ll see a window with the contents of the volume of the BeOS system. You may 
now drag and drop files between your Mac OS volumes and the BeOS volume to which you are 
connected.
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